KEYSIGHT

TECHNOLOGIES

Keysight E6640A EXM Wireless Test Set

Notice: This document contains references to Agilent.
Please note that Agilent’s Test and Measurement
business has become Keysight Technologies. For
more information, go to www.keysight.com.

Getting
Started Guide



Notices

© Keysight Technologies, Inc.
2008-2016

No part of this manual may be
reproduced in any form or by any
means (including electronic storage
and retrieval or translation into a
foreign language) without prior
agreement and written consent from
Keysight Technologies, Inc. as
governed by United States and
international copyright laws.

Trademark Acknowledgments

Manual Part Number
E6640-90001

Edition

Edition 1, March 2016

Supersedes: January 2016
Printed in USA/Malaysia

Published by:

Keysight Technologies
1400 Fountaingrove Parkway
Santa Rosa, CA 95403

Warranty

THE MATERIAL CONTAINED IN THIS
DOCUMENT IS PROVIDED “AS IS,”
AND IS SUBJECT TO BEING
CHANGED, WITHOUT NOTICE, IN
FUTURE EDITIONS. FURTHER, TO
THE MAXIMUM EXTENT PERMITTED
BY APPLICABLE LAW, KEYSIGHT
DISCLAIMS ALL WARRANTIES,
EITHER EXPRESS OR IMPLIED WITH
REGARD TO THIS MANUAL AND
ANY INFORMATION CONTAINED
HEREIN, INCLUDING BUT NOT
LIMITED TO THE IMPLIED
WARRANTIES OF
MERCHANTABILITY AND FITNESS
FOR A PARTICULAR PURPOSE.
KEYSIGHT SHALL NOT BE LIABLE
FOR ERRORS OR FOR INCIDENTAL
OR CONSEQUENTIAL DAMAGES IN
CONNECTION WITH THE
FURNISHING, USE, OR
PERFORMANCE OF THIS
DOCUMENT OR ANY INFORMATION
CONTAINED HEREIN. SHOULD
KEYSIGHT AND THE USER HAVE A
SEPARATE WRITTEN AGREEMENT
WITH WARRANTY TERMS

COVERING THE MATERIAL IN THIS
DOCUMENT THAT CONFLICT WITH
THESE TERMS, THE WARRANTY
TERMS IN THE SEPARATE
AGREEMENT WILL CONTROL.

Technology Licenses

The hardware and/or software
described in this document are
furnished under a license and may be
used or copied only in accordance
with the terms of such license.

U.S. Government Rights

The Software is “commercial
computer software,” as defined
by Federal Acquisition Regulation
(“FAR”) 2.101. Pursuant to FAR
12.212 and 27.405-3 and
Department of Defense FAR
Supplement (“DFARS”) 227.7202,
the U.S. government acquires
commercial computer software
under the same terms by which
the software is customarily
provided to the public.
Accordingly, Keysight provides
the Software to U.S. government
customers under its standard
commercial license, which is
embodied in its End User License
Agreement (EULA), a copy of
which can be found at
http://www.keysight.com/find/sweula
The license set forth in the EULA
represents the exclusive authority
by which the U.S. government
may use, modify, distribute, or
disclose the Software. The EULA
and the license set forth therein,
does not require or permit,
among other things, that
Keysight: (1) Furnish technical
information related to
commercial computer software
or commercial computer
software documentation that is
not customarily provided to the
public; or (2) Relinquish to, or
otherwise provide, the
government rights in excess of
these rights customarily provided
to the public to use, modify,
reproduce, release, perform,
display, or disclose commercial
computer software or
commercial computer software

documentation. No additional
government requirements
beyond those set forth in the
EULA shall apply, except to the
extent that those terms, rights, or
licenses are explicitly required
from all providers of commercial
computer software pursuant to
the FAR and the DFARS and are
set forth specifically in writing
elsewhere in the EULA. Keysight
shall be under no obligation to
update, revise or otherwise
modify the Software. With
respect to any technical data as
defined by FAR 2.101, pursuant
to FAR 12.217 and 27.404.2 and
DFARS 227.7102, the U.S.
government acquires no greater
than Limited Rights as defined in
FAR 27.401 or DFAR 227.7103-5
(c), as applicable in any technical
data.

Safety Notices

CAUTION
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Where to Find the Latest Information

Documentation is updated periodically. For the latest information about these products, including instrument software
upgrades, application information, and product information, browse to one of the following URLs, according to the name
of your product:

http://www.keysight.com/find/e6640a

To receive the latest updates by email, subscribe to Keysight Email Updates at the following URL:
http://www.keysight.com/find/MyKeysight

Information on preventing instrument damage can be found at:

www.keysight.com/find/PreventinglnstrumentRepair

ls your product software up-to-date?

Periodically, Keysight releases software updates to fix known defects and incorporate product enhancements. To search
for software updates for your product, go to the Keysight Technical Support website at:

http://www.keysight.com/find/techsupport
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Keysight E6640A
EXM Wireless Test Set

Getting Started Guide

1
Quick-Start

This section explains how to initialize the test set and generate and view a signal.
The following topics can be found in this section:

“About the Test Set" on page 12

“Initial Inspection" on page 14

“Test Set Location and Mounting Requirements" on page 16

“Turning on the test set the first time" on page 17

“Options and Licenses" on page 21

“Anti-Virus Software and Firewalls" on page 23

“Shortening the Test Set Power-On Time" on page 23

“Instrument Information" on page 24

KEYSIGHT
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Quick-Start

About the Test Set

12

The E6640A EXM Wireless Test set contains one to four Keysight M943xA TRXs.
The specific TRX model number is dependent on the options and applications
ordered with the test set:

— M9430A (with 2 half-duplex and 2 full-duplex ports) is the default TRX.
— M9431A (with 4 full-duplex ports) is supplied when option -4FD is ordered.

— M9432A (with 2 half-duplex and 2 full-duplex ports) is required for certain
802.11ac Wave 2 measurements (license V9077B-WFP or -WTP)

Each TRX contains the full set of hardware elements illustrated below, and is run
by its own instance of the XSA firmware application (a fully loaded test set shows
four independent XSA windows on its monitor display).

RF Input/
Output Matrix | (rF) Signal et Anfilg':er
_— Analyzer Sequencer
(Full Duplex)
RFIO2 «—» T
i{Sequence
i i Triggers)
RF3 1|0 *—, p
(Input or Source
TG Output) | P Signal [ (ControD List
— Source Sequencer
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Quick-Start 1

The TRX includes a signal analyzer and a signal source, both of which interface
with the front panel of the test set through an input/output matrix, and each of
which is controlled by an independent list sequencer (the two sequencers
exchange trigger signals to coordinate their operations). The input/output matrix
is illustrated below. Ports RFIO 1 and RFIO2 are full-duplex ports (simultaneously
inputs and outputs). Ports RF3 1|0 and RF4 1|0 can be inputs or outputs, but not
simultaneously. See also: “TRX Selection" on page 46, “Port Configuration" on
page 52, and “Option 4FD: Full Duplex Port Setup" on page 60.

Ports
e—{ 2
RF3 1|O > \' 3
e PIOHTY
® /_ Source
RFIO1 |« » SPLITTER/ |«
COMBINER
SPLITTER/ |«
RFIO 2 < » COMBINER b—e
) ’ \_, To
RF41|0 | / ) = Analyzer
L o . ]

Getting Started Guide

13



1T Quick-Start

Initial Inspection

Inspect the shipping container and the cushioning material for signs of stress.
Retain the shipping materials for future use, as you may wish to ship the test set to
another location or to Keysight Technologies for service.

ltem Deliverable Description
Getting Started Guide Provides first-time power on instructions,
—— licensing information, operating system
information, and general hardware
information.
USB keyboard & mouse A keyboard and mouse for communication with

the controller and measurement applications.
(These accessories are provided only if options

E6640A-KYB and E6640A-MSE are ordered.)

Monitor cable adapter An adapter for the front panel Display Port
(Display Port to VGA) 7 which makes it possible to use the test set
with a monitor which has a VGA connector.

Power cable Connection for test set power.

14 Getting Started Guide



Shipping

Getting Started Guide

Quick-Start

problems?

If the shipping materials are damaged or the contents of the container are
incomplete:

Contact the nearest Keysight Technologies office.

Keep the shipping materials for the carrier’s inspection.

If you must return an test set to Keysight Technologies, use the original (or
comparable) shipping materials. See “Returning a test set for Service" on
page 14b.

15



1T Quick-Start

Test Set Location and Mounting Requirements

=

16

Locating the test set

Make sure that the fan inlet and exhaust vent areas on the sides, bottom, and back
of the test set chassis are not obstructed. The minimal required clearance is 2
inches. Airflow restrictions cause additional airflow noise and cause the fans to
speed up so they can draw in enough air for the required cooling resulting in

excessive audible noise.

Cooling and rack mounting

Do not mount the test set side-by-side with any other instrument with

side-by-side ventilation. Make sure the exhaust air from one instrument is directed
away from the inlet of any other instrument (heated air directed into the inlet of an
instrument can cause instrument failure due to excessive operating temperatures).
The test set draws air in from the sides and bottom of the chassis and exhausts air

from the back.
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Turning on the test set the first time

Quick-Start 1

During the initial power-on process, the test set turns off and restarts several
times. This only happens during the initial installation process.

Initializing the test set using a USB mouse and external monitor

Steps

1 Connect a mouse and
keyboard

2 Connect a monitor

3 Power on the test set

4 Launch Microsoft Setup
Wizard

Actions

= Connect the mouse and

keyboard to two of the USB
ports on the front panel of the
test set.

Connect the monitor to the
monitor port on the front
panel of the test set.

Position the test set so you
have easy access to the
power cord and plug it in.
Press the power switch
(located near the top right
corner of the PXI rack) to
turn the test set on.

Highlight Microsoft Windows
and press Enter to start the
pre-installed operating
system.

Notes

= Model E6640A has no display; an external monitor is
required.

= See “Virtual Front Panel" on page 36.

= See “Test Set Location and Mounting
Requirements and “Power requirements" on
page 24 for more details.

= The test set can require more than 5 minutes to
power-on. This is affected by Windows start-up
requirements.

= The Keysight Technologies screen appears.

KEYSIGHT

TECHNOLOGIES

= At this time, it is safe to turn off the test set before
starting the Setup Wizard.

wWindows Boot Manager

To specify an advanced cption for this choice,

Getting Started Guide
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1T Quick-Start

Steps Actions Notes

a The analyzer performs the following steps:
= Windows Startup window
= Black screen
= Windows message window, “Please wait while windows prepares to setup”
= Keysight window
b At this time, it is safe to turn off the instrument before initializing the software.

CAUTION = After launching the setup, do not turn off the instrument or remove power before the Setup
Wizard completes and the system restarts. Turning off the instrument may corrupt the

system and the application may not operate.

5 Reboot and log on a Click OK. = When the instrument restarts, the following message
window appears:

|'\.‘erih'ir1ﬂ Mﬁ Documents setup...

= The system reboots.

= Several required processes continue.
= The system reboots.

= The XSA application initializes

6 Separate instances of the application are launched for each TRX installed in the PXI rack (they are identified as “TRX1”
through “TRX4” in the upper left corner of the application window). The verification procedures which follow should be done
for all TRXs.

- Kewsight - TRX4 - LTE FDD & LTE-A FDD - Channel Power

E Keysight - TRX3 - LTE FDD & LTE-A FDD - Channel Pouwer
I

S Ca
tori RO e Ve BB Keysight - TRX2 - LTE FDD & LTE-A FDD - Channel Pows
I

Ca
E KEHSK}M—TRX:;- LTE FDD & LTE-A FDD - Channel Power = "‘ - Kewsiah 1 BTEFDD & LTE-4 FOD - Chann
=14

T o T - BT L TR0l |00 AC
M i Carrier Ref Freq 1.00000000

" Keysight - TRX1 - L7 ruw & LTE-A FDD - Channel Power

s TRX1 - Front Panel

Ref -30.00 dBm
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Steps
7 Verify the installation a

8 Attach a loopback cable a

9 Generate and view a signal a

Actions

From the mouse right-click
menu, select Utility, Virtual
Front Panel. (All
key-presses that follow refer
to the keys shown on the
Virtual Front Panel.)

Press System, Show,
System.

Verify that the purchased
application(s) appear in the
list.

Use an RF cable to connect
the front panel RFIO 1 and
RFIO 2 ports for this TRX.

Press Input/Output, RF
Input, RF Input Port,
RFIO 1.

Press Input/Output, More,
RF Output & Test Set
Config, RF Output Port,
RFIO 2.

Press AMPTD Y Scale, Ref
Value, 10, dBm.

Press FREQ, Center Freq,
2.4, GHz.

Press SPAN X Scale, Span,
8, MHz.

Press Source, Frequency,
2.4, GHz.

Press Source, RF Output,
On.

Press Source, Amplitude,
RF Power, 0,dBm.

Quick-Start 1

Notes

= [fyou require further assistance, contact the Keysight

support team.
Online assistance: http://www.keysight.com/find/assist

The purpose is to use a loopback cable to verify that the
test set’s source can generate a signal and the test set’s
analyzer can measure it.

Select RFIO 1 as the input port

Select RFIO 2 as the output port.

Set the amplitude reference to 10 dBm

Set the analyzer center frequency to 2.4 GHz.

Set the analyzer span to 8 MHz.

Set the source frequency to 2.4 GHz.

Set the source RF output to On.

Set the source amplitude to 0 dBm.

To ensure accurate power levels from the source, see
“Alignments" on page 44.

Getting Started Guide
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1T Quick-Start

Actions Notes

= The 2.4 GHz signal appears on the display.

W Vgt - TR 10 Aabyrer Masic) - Comples Spactram Petetype - Limited Sale Allwed]

- - A
Marker 1 X 2.400029197 GHz ) Center Freg; 2.400000000 GHz

Trig: Free Run Avg|Held:> 25025
Range: 0 d5m

Ref 10 dBm

Center 24 GHz i i Span 8 NIHz
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Quick-Start 1

Options and Licenses

The options and licenses installed on the test set are listed on the System > Show
> System display, as illustrated below. Certain features of the test set (such as its
frequency range, its analysis bandwidth, the measurement applications it runs,
and in some cases individual measurements within an application) are licensed
features, and are unavailable if the appropriate license is not installed.

Hard ware-related options such as frequency range and analysis band width are
specific to the TRX; measurement applications apply to any TRX in the same
test set chassis.

TR T pesERNO GAA 767 T e
mONS Enabled res
mONS Host Name A-EBB40A-0111-2
mONS Service Name Keysight PCSERNO YWireless Connectivity Test Set- SC29.
Option Mame / Description
EE6404-504 Frequency Range, 3.8 GHz
EBE404-PCX Intel{R) Core(TH) i7-36100E CPU @ 2.30GHz, 4 GB
EGE40AMTX ‘Windows Embedded Standard 7, 64 bit OS5
EGEL04-506 Frequency Range, 5.0 GHz
EE6404-B40 Analysis bandwidth, 40 MHz
EBE640A-RFO RFIO
EE6404-SRC Signal Source
MN76994-D24 Measurement Applications Temporary License - demo only
WA0E0A-2FF Test Set Measurement Application
WA0E3A-ZFFP Analog Demod Measurement Application
WA0EhA-ZFF Sequence Analyzer for MS Application
WA0T1A-ZFFP GSMIEDGE Measurement Application
WA0T71A-3FF EDGE Evolution Measurement Application

For many of the measurement applications, the license is listed here in
separate "A" and "B" versions. For example, when the "V9071B-2FP" license is
purchased and installed, the "V9071A-2FP" license is automatically installed
along with it. This is not an error; both versions of the license should be
present.

Getting Started Guide 21
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Quick-Start

Option 4FD

Option 4FD modifies the RFIO interface of the E6640A EXM Wireless Test Set as
follows:

All four ports on each module are full-duplex ports (that is, any port can be
used simultaneously as an RF input (to the test set’s analyzer) and as an RF
output (from the test set’s source).

Each TRX in the test set has the model designation M9431A, not M9430A or
M9432A.

The port designations on the front panel are: RFIO 1, RFIO 2, RFIO 3, and RFIO
4.

Performance characteristics for all four ports are same as those described for
ports RFIO T and RFIO 2 in the E6640A EXM Wireless Test Set Data Sheet.

Port settings under the Input/Output menu (and equivalent SCPI commands)
are modified accordingly.

Any of the TRX’s four RFIO ports can be configured as a full duplex port; it can also
be configured as an input port (accepting a signal to be analyzed), with a separate
port configured as an output port (providing an RF stimulus). The configuration
details are described in “Option 4FD: Full Duplex Port Setup" on page 60 and
“Option 4FD: Separate Input and Output Port Setup" on page 61.

Getting Started Guide



Quick-Start 1

Anti-Virus Software and Firewalls

No anti-virus software is shipped with the test set. It is recommended that you
install anti-virus software if your test set is connected to the LAN. Check with your
IT department to see what they recommend.

The test set is shipped with the Windows firewall enabled. Do not modify the
default network settings as this may cause problems with the operating system of
the test set.

Shortening the Test Set Power-On Time

The test set desktop includes a shortcut to the ConfigureApplications.exe
application that lets you control your test set power-on configuration. You can set
the configuration to pre-load only the applications that you typically run. This can
significantly shorten the time it takes for your test set to power-on. You can also
access this functionality by pressing: System, Power On, Configure Applications.
(These key-presses refer to the Virtual Front Panel; see “Virtual Front Panel" on
page 36.)

If (after power-on) you want to access an application that you did not pre-load, it
will take a little longer to bring it up once you press the application softkey. This
longer time-frame is only for the first access after power-on. After the initial
access, mode (application) switching will operate as quickly as if the application
was pre-loaded.

Getting Started Guide 23



1T Quick-Start

Instrument Information

Power requirements

The only physical installation of your Keysight test set is a connection to a power
source. Line voltage does not need to be selected.

This test set does not contain customer serviceable fuses.

This is a Safety Class 1 Prod uct (provided with a protective earthing ground
incorporated in the power cord). The mains plug shall only be inserted in a
socket outlet provided with a protective earth contact. Any interruption of the
protective cond uctor inside or outside of the product is likely to make the
prod uct dangerous. Intentional interruption is prohibited. (IEC 348 clauses
17.3.3c &17.3.4)

Failure to ground the test set properly can result in personal injury. Before
turning on the test set, you must connect its protective earth terminals to the
protective cond uctor of the main power cable. Insert the main power cable
plug into a socket outlet that has a protective earth contact only. DO NOT
defeat the earth-grounding protection by using an extension cable, power
cable, or autotransformer without a protective ground cond uctor.

This product is designed for use in Installation Category Il and Pollution
Degree 2.

This instrument has autoranging line voltage input. Before switching on the
instrument, be sure the supply voltage is within the specified range.

The Mains wiring and connectors shall be compatible with the connector used
in the premise electrical system. Failure, to ensure adequate earth grounding
by not using the correct components may cause product damage, and serious

injury.

24
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Quick-Start 1

AC power cord

The test set is equipped with a three-wire power cord, in accordance with
international safety standards. This cable grounds the test set cabinet when
connected to an appropriate power line outlet. The cable appropriate to the
original shipping location is included with the test set. See:

http://www.keysight.com/find/powercords
Always use the three-prong AC power cord supplied with this product. Failure

to ensure adequate earth grounding by not using this cord can cause product
damage.

This instrument has auto-ranging line voltage input; be sure the supply voltage
is within the specified range and voltage fluctuations do not to exceed 10
percent of the nominal supply voltage:

100/120 VAC 50/60 Hz, 1000 W MAX
220/240 VAC 50/60 Hz, 1200 W MAX.

If this prod uct is not used as specified, the protection provided by the
equipment could be impaired. This prod uct must be used in a normal
condition (in which all means for protection are intact) only.
Install the instrument so that the detachable power cord is readily
identifiable and easily reached by the operator. The detachable power cord is
the instrument disconnecting device. It disconnects the mains circuits from
the mains supply before other parts of the instrument. The front panel switch
is only a stand by switch and is not a LINE switch. Alternatively, an externally
installed switch or circuit breaker (which is readily identifiable and is easily
reached by the operator) may be used as a disconnecting device.

Environmental Conditions (Operating)

This product is designed for use in the following conditions:
For indoor use only
Temperature 5°C to 45°C
Altitude up to 3048 meters

0% Relative Humidity to 90% Relative Humidity up to 40°C, and linearly
decreasing to 50% Relative Humidity up to 45°C; non-condensing.

This product is designed for use in Installation Category Il and
Pollution Degree 2.

Getting Started Guide 25
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Quick-Start

Ventilation

— — VENTILATION REQUIREMENTS: When installing the product in a cabinet, the

CAUTION convection into and out of the product must not be restricted. The ambient
temperature (outside the cabinet) must be less than the maximum operating
temperature of the product by 40C for every 100 watts dissipated in the
cabinet. If the total power dissipated in the cabinet is greater than 800 watts,
then forced convection must be used.

Instrument Maintenance

Cleaning the instrument

To prevent electrical shock, disconnect the test set from mains before
WARNING cleaning. Use a dry cloth or one slightly dampened with water to clean the

external case parts. Do not attempt to clean internally.

Cleaning the connectors

Cleaning connectors with alcohol shall only be done with the instrument
WARNING

power cord removed, and in a well-ventilated area. Allow all resid ual alcohol
moisture to evaporate, and the fumes to dissipate prior to energizing the
instrument.

Getting Started Guide



Quick-Start 1

Battery Information

The test set uses a lithium battery located on the CPU board. This is not an
operator replaceable part. See “Returning a test set for Service" on page 145.
Replaceable parts must be approved or supplied by Keysight Technologies.

You can order the service documentation for the instrument through your Keysight
Sales and Service office.

Danger of explosion if battery is incorrectly replaced. Replace only with the
WARNING same or equivalent type recommended. Discard used batteries according to

the manufacturer’s instructions.

Do not throw batteries away but collect as small chemical waste.

DO NOT THROW BATTERIES AWAY BUT
COLLECT AS SMALL CHEMICAL WASTE.
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Quick-Start

Protecting against electrostatic discharge

Electrostatic discharge (ESD) can damage or destroy electronic components (the
possibility of unseen damage caused by ESD is present whenever components are
transported, stored, or used).

Test equipment and ESD

To help reduce ESD damage that can occur while using test equipment:

Do not use these first three techniques when working on circuitry with a
WARNING voltage potential greater than 500 volts.

Before connecting any coaxial cable to a test set connector for the first time
each day, momentarily short the center and outer conductors of the cable
together.

Personnel should be grounded with a T MQ resistor-isolated wrist-strap before
touching the center pin of any connector and before removing any assembly
from the test set.

Be sure that all instruments are properly earth-grounded to prevent build-up of
static charge.

Perform work on all components or assemblies at a static-safe workstation.
Keep static-generating materials at least one meter away from all components.
Store or transport components in static-shielding containers.

Always handle printed circuit board assemblies by the edges. This reduces the
possibility of ESD damage to components and prevent contamination of
exposed plating.

Additional information about ESD

For more information about ESD and how to prevent ESD damage, contact the
Electrostatic Discharge Association (http://www.esda.org). The ESD standards
developed by this agency are sanctioned by the American National Standards

Institute (ANSI).
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?
Front and Rear Panel Features

This section describes the following features:
“Front-Panel Features" on page 30
“Display Annotations" on page 38
“Rear-Panel Features" on page 40

“Front and Rear Panel Symbols" on page 41
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2 Front and Rear Panel Features

Front-Panel Features

The test set consists of instruments loaded in a PXI rack, hidden behind a front
panel. There is a controller (located on the far left), and one to four TRX
(transmit/receive) sub-instruments, each of which includes an RF signal generator

and an RF signal analyzer. A frequency-reference instrument, shared by all the
TRX sub-instruments, is placed in the center.

_w
@ o
e

LAY

B —
fBeooEHo
=kl —E

. L_-‘[a;ntroller '
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Front and Rear Panel Features 2

Controller Hardware Interface

The controller’s front panel features are illustrated below:

L
Item # Item Description
1 Monitor Port This connector supports a connection to a monitor with a
DisplayPort input.
2 LED Indicators +  DRIVE: When the Solid State Drive is active, the LED will flash.

POWER: If the LED is on, the power supply to the controller is good
and the system should boot.

USER: Not used.

3 TRIG This trigger line is not used by the E6640A.
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2 Front and Rear Panel Features

ltem # Item Description

4 LAN Connectors Two TCP/IP Interface connectors that are used for remote test
set operation. Choose the LAN 1 port to have an IP address
assigned to the test set dynamically, using DHCP. If your local
network does not support DHCP, choose the LAN 2 port to use
a private static IP address. For more information, see “LAN
Address Configuration" on page 62.

5 USB 3.0 The controller provides two USB 3.0 ports.
6 USB 2.0 The controller provides four USB 2.0 ports.
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Front and Rear Panel Features 2

TRX Module Hardware Interface

There can be as many as four TRX modules in the PXI rack; each has the same
hardware interface, as illustrated below.

If the E6640A test set was purchased with Option 4FD, all four

RF ports have full-duplex capability, therefore two of the ports
are labeled and used differently than they are described below.
For details, see “Option 4FD" on page 22, “Option 4FD: Full
Duplex Port Setup" on page 60 and “Option 4FD: Separate Input
and Output Port Setup" on page 61.

TRX1 —

| TRxy
| smarus

AW

ltem # ltem Description

1 TRXn STATUS After line power is applied to the PXI chassis, the STATUS LED
for each TRX module lights red when the software application
controlling the TRX hardware begins loading, and green when
the software application is ready.

2 RFIO 2 This Type N connector is a full-duplex RF input/output port.
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2 Front and Rear Panel Features

ltem # Item Description
3 RFIO 1 This Type N connector is a full-duplex RF input/output port.
4 TRIG OUT 2 A trigger output used to synchronize other test equipment with

the test set. Configurable from the Input/Output keys.

5 TRIGIN 1 A trigger input used to synchronize other test equipment with
the test set. Configurable from the Input/Output keys.

6 RF4 1/0 This Type N connector is a half-duplex RF port which can be
configured as an input or an output. (If Option 4FD is installed,
see “Option 4FD" on page 22.)

7 RF31/0 This Type N connector is a half-duplex RF port which can be
configured as an input or an output. (If Option 4FD is installed,
see “Option 4FD" on page 22.)

8 TRIG OUT 1 A trigger output used to synchronize other test equipment with
the test set. Configurable from the Input/Output keys.

9 TRIG IN 2 A trigger input used to synchronize other test equipment with
the test set. Configurable from the Input/Output keys.
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Front and Rear Panel Features 2

Reference Module Hardware Interface

The connectors which are exposed when the impact cover is in place are
illustrated below:

— REF —

L1 TRX] [*7}
ETATUS STATUS

) (

Iltem # Item Description

1 10 MHz OUT This BNC input port provides a timebase reference output from
the M9300A Reference module.

2 REF IN This BNC input port accepts a timebase reference input to the
Ref In port of the M9300A Reference module.
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2 Front and Rear Panel Features

Virtual Front Panel

The E6640A model does not include physical front-panel keys. However, if you
have a PC mouse, monitor, and keyboard plugged in (or are working through a
Remote Desktop interface), you can navigate front-panel functions using the
virtual front panel (VFP) shown below. Access the VFP as follows:

1. Right-click the mouse.
2. Left-click Utility (1) in the menu, as shown below.
3. Left-click Virtual Front Panel (2) in the menu, as shown below.

The PC mouse and monitor are required when using the E6640A. For ease in
using the VFP, the PC keyboard is recommended.

Setup 4
Marker »
Control >
Mode 4
Meas >
Mode Preset
User Preset
Window 4
File
Quick Save Save
Return Recall
Local
Help Page Setup
Print

Exit ]
Virtual Front Panel

On the VFP the keys labeled "Key 1" through "Key 7" function as the menu keys.
Using the mouse to click on a combination of the VFP keys and the menu keys on
the display screen, you can operate the instrument as if it had conventional
front-panel keys. The VFP frame shows “Left” or “Right” at the upper left corner of
the frame, so that it’s clear which sub-instrument within the PXI rack is being
controlled by it.
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Front and Rear Panel Features

s TRX1 - Front Panel o] &) ==
FREQ Input/ Auto ‘ Mode
SoftKey 1| | Channel Qutput Couple Marker System Preset
— SPAN View/ BW Peak Quick User
X Scale Display Search Save Preset
SoftKey 2| | AmpTD || Traces Marker .
Y Scale Detector Source , Save File
Mode Marker
SoftKey 3 Mode setup Trigger Eiiniction Recall Print
— Meas [ msp g:ﬁgﬂ: Restart J Single Cont ]
SoftKey 4
Full Next Cancel Bk Sp
L | sereen Zoom Windov Vol Up (Esc) Delete )
SoftKey 5 t VolDn || 7 8 9
| « ‘ Enter » Mute 4 5 6
SoftKey 6
— I 1 2 3
SoftKey 7 Select/ Tab Tab
‘ LEE | Return Space - - 0 -

When the Test Set is Controlled Remotely

The test set can be controlled remotely, from another computer. (See “Remote

2

Desktop: Using the Test Set Remotely" on page 119.) When the test set is being
controlled remotely, a log-on screen is displayed on the monitor.

Under these circumstances, pressing the front-panel Power switch does not
immediately turn instrument power off. Instead, the following message appears:

Other people are logged on to this computer. Shutting down

windows might cause them to lose data. Do you want to continue
shutting down?

Although pressing and holding down the Power button will force a power

shutdown, this is not recommended; use the Windows shutdown function instead.

Do not shut down power by pulling out the power plug; this will damage the
power supply.

Getting Started Guide
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Front

Di
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and Rear Panel Features

splay Annotations
3

4 5

R

[n‘.Le&-AgnentWLAN- Channel Power
A REF 50 0 A\ AC

(Prototype - Limited Sale Allowe: \
SENSE:INT| RF ON [ ANALIGN PAQTIAL [ 04:25:36 PMJun27,

Center Freq: 1.000000000 GHz
Avg|Hold:=> 10110

Ref Value -10.00 dBm

rass |

G, Trig:Free Run
Range: 0 dBm

Radio Std: 11alg
Mod Format: AUTO
guard Intvl: 114

Ref -10.00 dBm

VBW 1MHz
Channel Power

-73.07 dBm /20 MHz

11\A

10

Power Spectral Density

-85.27 dBm /Mhz

Measurement bar; shows general measurement settings
and information. Some measurements include limits which
the data is tested against. A Pass/Fail indication may be
shown in the lower-left corner. The following graphics
indicate single/continuous measurement:

——

Iltem # Description Function Key

All the keys in the test set Setup part of the
front panel.

Active Function (measurement bar); when the current
active function has a settable numeric value, it is shown
here.

Currently selected front panel key.

The TRX sub-instrument associated with the application
(identified as “TRX1” through “TRX4”). This is needed
because the E6640A can include up to four independent
TRX sub-instruments in one PXI rack.

Banner; shows the name of the selected application that is
currently running.

Mode

Measurement title; shows title information for the current
measurement, or a title that you created for the
measurement.

Meas
View/Display, Display, Title
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Front and Rear Panel Features 2

Iltem # Description Function Key

6

Settings panel; displays system information that is not
specific to any one application.

Input/Output status - green LXI indicates the LAN is
connected. RLTS indicate Remote, Listen, Talk, SRQ

Input impedance and coupling
Selection of external frequency reference

Setting of automatic internal alignment routine

Local and System, I/O Config,
Input/Output, Amplitude, System, and
others

Active marker frequency, amplitude, or function value

Marker

Settings panel; time and date display

System, Control Panel

Trace and detector information

Trace/Detector, Clear Write (W)
Trace Average (A) Max Hold (M)
Min Hold (m)

Trace/Detector, More, Detector,
Average (A) Normal (N) Peak (P)
Sample (S) Negative Peak (p)

10

Key labels that change based on the most recent key press

Softkeys

N

Displays information, warning, and error messages.
Message area: single events. Status area: conditions.

12

Measurement settings for the data currently being
displayed in the graticule area. In the example above:
center frequency, resolution band width, video band wid th,
frequency span, sweep time and number of sweep points.

Keys in the test set Setup part of the front
panel.

Getting Started Guide
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2 Front and Rear Panel Features

Rear-Panel Features

Iltem # Name Description

1 Line power input The AC power connection. See the product specifications for more details.
2 FAN Fan speed control (settings are HIGH and AUTO).
3 INHIBIT Inhibit switch. The settings are DEF (default) and MAN (manual).
When the switch is in the default position, the chassis is powered up by the
front panel ON/Stand by pushbutton. This is the recommended setting.
When the switch is in the manual position, the chassis is powered up by the
Inhibit input signal on the rear panel INHIBIT/VOLTAGE MON DB-9
connector.
4 INHIBIT/ This DB-9 connector provides access for testing of internal power supply
VOLTAGE MON voltages. The voltages (by Pin #) are: (1) Logic Gnd, (2) +5 VDC, (3) Rsrvd, (4)
+3.3 VDC, (5) Inhibit [Low], (6) +12 VDC, (7) Rsrvd,
(8)-12 VDC, (9) Logic Gnd.
5 10 MHz REF OUT  This BNC connector is not used by the E6640A test set. The front panel 10 MHz
OUT connector should be used instead.
6 10 MHz REF IN This BNC connector is not used by the E6640A test set. The front panel REF IN

connector should be used instead.

40
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Front and Rear Panel Features 2

Front and Rear Panel Symbols

This symbol is used to indicate power ON (green LED).

This symbol is used to indicate power STANDBY mode (yellow

I
(!) LED).

~ This symbol indicates the input power required is AC.
The instruction documentation symbol. The product is marked

A with this symbol when it is necessary for the user to refer to
instructions in the documentation.

ce The CE mark is a registered trademark of the European
Community.

@ The RCM Mark is a Compliance Mark according to the ACMA
Labelling Requirement.

This is a marking of a product in compliance with the Canadian
I1SM GRP.1 CLASS A

Interference-Causing Equipment Standard (ICES-001). This is
also a symbol of an Industrial Scientific and Medical Group 1
Class A product (CISPR 11, Clause 4).

The CSA mark is a registered trademark of the Canadian
‘SB ® Standards Association International.
C Us

South Korean Class A EMC Declaration
AZ I (YRE BESSHIIXM)
o] 7171 954 (A F) AATFHR77I2A4 T dfzA & AR E ©] & F
LNS  gsari e o, bae A9 Aeste A 23 = S
REM-Kst-
13E6640A This equipment is Class A suitable for professional use and is for use in

electromagnetic environments outside of the home.

This symbol indicates separate collection for electrical and
electronic equipment mandated under EU law as of August 13,
2005. All electric and electronic equipment are required to be
separated from normal waste for disposal (Reference WEEE
Directive 2002/96/EC).

substance elements are expected to leak or deteriorate during
normal use. Forty years is the expected useful life of the product.

I
p Indicates the time period during which no hazardous or toxic

40
ey This symbol on all primary and secondary packaging indicates
=; compliance to China standard GB 18455-2001.

To return unwanted products, contact your local Keysight office.
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Operating Tasks

“Alignments" on page 44

“TRX Selection" on page 46

“E6640A Calibration Status" on page 48
“Desktop Icons" on page 50

“Port Configuration" on page 52

“LAN Address Configuration" on page 62
“Switched MIMO" on page 63

“True MIMO" on page 71

“Tx Beam Forming" on page 82
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Operating Tasks

lignments

Alignments are internal calibration adjustments which each TRX module must
make to ensure that internal signal levels are properly maintained. To avoid
interruptions, the alignments are not run automatically, either at startup or
afterward; you must run them explicitly.

“All” Alignment (daily use)

This alignment of the source and analyzer in the TRX is sufficient to maintain
specified performance, provided that (1) the TRX’s internal temperature has not
drifted more than 5 degrees C since the previous alignment, (2) no more than 8
hours have elapsed since the previous “All” alignment, and (3) no more than 1
week has elapsed since the previous weekly alignment (see below). The “All”
alignment typically takes less than 5 minutes to run.

The TRX’s internal temperature can be checked by sending the SCPI query
:CAL: TEMP: CURR?

To run the alignment, select System > Alignments > Align Now > All, or send the
SCPI command :CAL:ALL.

The alignment process requires a 45-minute preliminary
warm-up period, after applying power or after restarting the
XSA application (when the application is not running, power is
not applied to the TRXs; therefore an application shutdown has
the same effect on alignment as a power shutdown).

NOTE
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Operating Tasks 3

Weekly alignment procedure

A more thorough alignment of the source and analyzer in the TRX is required on a
weekly basis. This procedure is similar to the “All” alignment described above, but
it also performs additional alignment functions related to slow-drifting parameters
which do not change significantly over time periods shorter than a week.

1. Select System > Alignments > Align Now > IF, or send the SCPI commands:
:CAL: IF
*WAT

2. Select System > Alignments > Align Now > RF, or send the SCPI commands:
:CAL:RF
*WAT

3. Select System > Alignments > Align Now > Source, or send the SCPI
commands:
:CAL:SOUR

*WAT

This alignment process also requires the same 45-minute
preliminary warm-up period described above.
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TRX Selection

46

On the monitor or remote desktop view of the test set, each TRX is represented by
a separate XSA window. You can identify which TRX a window controls by looking
for the identifier (TRX1 through TRX4) at the top left corner of the window. (The
TRXs are placed in numerical order in the PXle chassis, beginning with TRX1 on

the left.)

BN Keysight - TRX4- LTE FDD & LTE-A FDD - Channel Power

Carrler Ref Freq 1. DUUDU

Ref -30.00 dBm

Although the test set as a whole is assigned only one IP address for the entire PXle
chassis, the individual TRXs within the chassis can be differentiated in network
communication with the test set. The means of identifying a TRX depends upon
the connection method, as outlined below.

Using HISLIP

HiSLIP (High-Speed LAN Instrument Protocol) is the
recommended interface for connection to the E6640A, because

of its superior performance characteristics.

Use hislipO through hislip3:

TRX1:

TCPIPO:

TRX2 :

TCPIPO:

TRX3:

TCPIPO:

TRX4 :

TCPIPO:

:<IP Address>:

:<IP Address>:

:<IP Address>:

:<IP Address>:

:hislipO:

:hislipl:

:hislip2:

:hislip3:

: INSTR

: INSTR

: INSTR

: INSTR
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Using Socket Ports

Use sockets 5025, 5125, 5225, and 5325:

Using VXI-11/SICL
Use instO through inst3:

TRX1:

TCPIPO: :<IP Address>:

TRX2:

TCPIPO: :<IP Address>:

TRX3:

TCPIPO::<IP Address>:

TRX4 :

TCPIPO: :<IP Address>:

Using Telnet Connection

Use telnet ports 5023, 5123, 5223, 5323:

Getting Started Guide

TRX1:
5023

TRX2:
5123

TRX3:
5223

TRX4 :
5323

:instO0::

:instl:

:inst2:

:inst3:

INSTR

: INSTR

: INSTR

: INSTR

Operating Tasks
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3 Operating Tasks

E6640A Calibration Status

BN Keysight (E F1 ,Sequence Analyzer - List Sequencer

The E6640A EXM test set does not have a calibration certificate, because of its
flexibility in configuration:

The E6640A chassis can have 1, 2, 3, or 4 TRXs (M943xA) installed.

Different TRXs can have different hardware configurations for frequency range
and/or bandwidth.

Additional TRXs can be added to an E6640A chassis after the initial instrument
purchase. These would have different calibration due dates, and different
warranty end dates, from the modules that were originally purchased with the
E6640A.

There isn’t a single instrument-level calibration (or calibration due-date) that
covers the E6640A as a whole and all of the TRX modules (and the Reference
module) within it. Each module is calibrated independently, and not necessarily at
the same time that the others in the test set are calibrated.

The only way to track the calibration status of the E6640A is to track the
calibration status of the reference module, and each TRX module, within it. The
serial number of a particular module can be found from its XSA window, by
selecting System > Show > Hardware on the Virtual Front Panel. The serial number
is listed in the row which shows “Reference” or “M943x TRX” under Assembly
Name. The same row also shows the Cal Date and Cal Interval for the relevant
module

(Prototype - Limited Sale Allowed)

L RFIO1

500  AC [

SENSE:INT| RF OFF [ /\ALIGN OFF [
Total Acq: 1
1 Total Steps: 1

10:38:02 AM Aug 28
Current Acq: 1
Current Step: 1 of 1

e

! Qutput:RFIO1

Hardware Information

Weysight EXM Wireless Test Set

Product Number: EB640A

Serial Mumber: US00000001

Instrument SAY Revision: E 14 50 _R0O017

Rewision Date: 8/28/2014 10:31:33 AM

Assermnbly MName Part # Serial # Matl Rev  Rev OFRev Hwld Cal Date Cal Interval
Pxle Confroler Pixle-8135 0 174

Reference MW19E008 ILIS52360177 0185 2013.06.28 2 years
Reference Carrier [W19E0048 W1312-63281-23-1249-00095 01 121 016

Reference Plugin MA3004A W1312-63286-30-1250-00043 01 1.2.0 0167

Chassis MI01ZA TW53330145 0 171

Wideband Digitizer MI43063005 00000000028 001 0 0 138

DownCorverter MIA3063005 000000000 28 ool ol A 139

RFIC MIA3063009 000000000 28 ool 0 A 140

Poweer Supply MI43063002 00000000028 001 0 A 141

(9420 TRX) 9142601882  SMNOOOODO00 0 0 0 142 1970.01.01 1 year
Rasehand Generator MI43063007 00000000028 0oz 8] 8] 136
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Operating Tasks 3

The same hardware information is also returned by the SCPI command:
SYST: CONF : HARD?

Certificates of Calibration

Customers receive 2 to 5 Certificates of Calibration (COCs) with the E6640A EXM
test set. The EXM is a scalable test set and can be purchased with 1 to 4 TRX
modules. The TRX modules, along with the Reference module (supplied with each
E6640A), are the only items that require calibration, and therefore they are the only
items supplied with a CoC and calibration sticker at shipment.

Each E6640A test set is shipped with a yellow envelope which contains your
calibration certificates; this envelope is labeled (lower right corner) with a sticker
identifying the unit model number (E6640A) and serial number. Inside each
envelope will be from two to five CoCs: one for the reference module, and one for
each of the TRX modules installed in the test set. This package constitutes your
test set’s calibration data.

Certificate of Calibration

Two(2) to five(5) CoC’s
based on one(1) to

Certificate of Calibration fou r{d] TRX ordered
_ l Certificate of Calibration

Certificate of Calibration

Certificate of Calibration

You may choose to physically attach calibration stickers to your E6640A test set
(recommended), or, as many customers do, you may choose to use the modules’
electronic calibration information to identify the calibration status of any module
at any time. The use of electronic calibration information is of benefit to those
customers that may want to move modules from one instrument to another: the
calibration date always follows the module.

To summarize: calibration of the E6640A is not done at the instrument level, but an
E6640A is fully calibrated when all of the modules (Reference module and TRX
modules) are calibrated. At initial shipment, this information is provided in the
yellow envelope supplied with each unit.
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Desktop Icons

Three desktop icons provide access to utilities which support the E6640A's
measurement firmware.

Configure Applications

TRX Configurator

Launch XSA

TRX Configurator

The TRX Configurator tool shows which of the four possible TRXs are installed in
the PXle rack, and identifies them by SCPI address. At a minimum, TRXT must be
installed, and cannot be disabled using this tool. However, the other TRXs, if
installed, can be enabled or disabled using the checkbox in the right column.

ﬁ
B Agilent TRX Configurator

TRX 1 Installed | TCPIPO: WINDOWS-HULTTGC:inst0:INSTR | Enatile?

TRX 2 Mot Installed | . | Enable?

TRX 3 Installed ‘ TCPIPO WANDOWS-HULTTGC:inst2 INSTH Enable?

TRX 4 Not Installed _| Enable?
Save UpdaleFPGA, Evit

Status

The UpdateFPGA button is used when installing a new TRX into an E6640A which
was purchased without it, to ensure software compatibility.
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Launch XSA

On bootup, the E6640A opens an XSA application window for each TRX which is
(1) installed and (2) enabled in the TRX Configurator described above.

If you have closed any of the XSA application windows, you can reopen them
without rebooting, by clicking the Launch XSA icon. This will only open a window
for a given TRX if it is enabled in the TRX Configurator.

Configure Applications

Click the Configure Applications icon to launch this utility, which allows you to
specify which of the E6640A’'s measurement applications will be preloaded into
memory at startup. Preloading the most frequently-used applications is a
convenience (however, selecting fewer of them for preload shortens the startup
time and uses less memory).

B Configure X-Series Applications @
This utility lets you configure your applications as follows:
1. To reduce the analyzer startup time check only the applications you want to preload. Selected (checked) applications preload at
startup. Unchecked applications take longer to load the first time they are run after startup.

2. There are more applications available for the X-Series than can fit into memory at any one time. This utility will not let you preload
more applications than will fit into memory at once. The colored bar indicates the total memory required when all checked
applications are loaded {ether preloaded or selected during runtime).

3. To navigate to-an application, select it by mouse. To select or deselect an application, chck the checkbox.

4, To modify the order in which the applications appear in the Mode menu, select an application and move it up or down using the
“Move Up" or "Move Down" keys,

5. To selectthe application which first runs when the analyzer starts up, use "Select Power On Application” pull-down menu.
Select Appli cations to preload at analyzer startup

|
INSTISEL INSTINGEL  MBytes * { SelectAll |
v -
@ 1Q AJ-aJ\ e |F“mrl' rmr 100 [Desmw‘mli
¥ w-coMA WCDMA 9 304 |
¥l GSM/EDGE EDGEGSM 13 69 7
V] 802.16 OFDMA WIMAXOFDMA 75 85 : .
71 WA Vector Signal Analyzer VSA 100 a1 l Move Up ]
¥ Anglog Demod ADEMOD 234 1274
¥] Bluetooth BTooth 228 174 Move Down |
¥ TD-SCOMA TDSCOMA, 21 174 -
¥ edma2000 COMAZK 10 192
| 7] LEV-DO COMALXEV 15 217 -
Estimated Virtual Memory Used: 5387 MBytes  Avalable: 6301 MBytes  Limit: 12288 MBytes * Power On Applcation
0 252 4504 6756 9002 11260 13512
(MBytes)
Select Power On Application
|1Q Analyzer (Basic) .

[ Show this at startup iF virtual memory usage exceeds the limit. | oK l | Eancel

A selector at the lower left of the window allows you specify which application will
be running when the E6640A starts up.
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Port Configuration

52

Any of the TRXs four RF ports can be configured as an input port (accepting a
signal to be analyzed) or as an output port (providing an RF stimulus). Two of the
ports (RFIO 1 and RFIO 2) can also be used in full-duplex mode (that is, with a
single port used for both input and output simultaneously). The various possible

configurations are described here.

Full Duplex Port Setup (RFIO 1 and RFIO 2)

If the test set was purchased with Option 4FD, all four RF ports
have full duplex capability, and port configuration is handled
differently. For details, see “Option 4FD: Full Duplex Port
Setup" on page 60 and “Option 4FD: Separate Input and Output

Port Setup" on page 61.

Ports RFIO 1T and RFIO 2 connect to a splitter/combiner rather than a switch, so

they can be used in full duplex mode.

Ports

RF3 1|0

Input/Output
(Full Duplex) A0

RFIO 2

RF4 1|10

F 9

F

|-

»| SPLITTER/

F 3

3

COMBINER

SPLITTER/

COMBINER

v

i From
Source

-

F 3

3

A 4

~N

L 4

L ]

v w

L]

&
&

To
Analyzer

To use the RFIO 1 port as the input and output, set up the RF Input using this

menu setting or its equivalent command:

Input/Output > RF Input > RF Input Port > RFIO 1

Command:

:FEED:RF:PORT RFIO1

Then set up the RF Output using this menu setting or its equivalent command:

Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 1

Command:

:FEED:RF:PORT:OUTP RFIO1
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Input/Output
(Full Duplex)

Getting Started Guide
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Ports
RF3 1|0 | & -
z < From
< Source
RFIO 1 + » SPLITTER/ j4— 2
COMBINER
SPLITTER/ |«
RFIO 2 * * COMBINER »—e
—. i [ To
T ol | Analyzer
RF4110 | \

To use the RFIO 2 port as the input and output, set up the RF Input using this
menu setting or its equivalent command:

Input/Output > RF Input > RF Input Port > RFIO 2

Command:
:FEED:RF: PORT RFIO2

Then set up the RF Output using this menu setting or its equivalent command:

Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 2

Command:
:FEED:RF: PORT : OUTP RFIO2
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Separate Input and Output Port Setup (RF3 1|0 and RF4 1|0)

Input

Output

Ports RF3 1|0 and RF4 1|0 connect to a switch rather than a splitter/combiner,
which means that one of these ports must be used as either an input or an output,
not both, at any given time. (However, because there is less RF path loss when a
switch is used, these ports are preferred in situations where it is important to
maximize RF power to the analyzer or from the source.)

Ports
RF3 1|0 » .
> F From
=/ Source
RFIO1 |« »| SPLITTER/ |4— —1 %
COMBINER
SPLITTER/ |«
RFIO2 [« » COMBINER »—e
o 1 \ , To
b »l o Analyzer
RF410 |¢ 4 d e ¥

To define RF3 1|0 as an input and RF4 1|0 as an output, use the following steps.
Define RF3 1|0 as an input, using this menu setting or its equivalent command:

Input/Output > More > RF Output & Test Set Config > Half Duplex Config >
RF Input Port > RF3 1|O

Command:
:HDUPlex: PORT: INPut RFIO3

Define RF4 1|0 as an output, using this menu setting or its equivalent command:

Input/Output > More > RF Output & Test Set Config > Half Duplex Config > RF
Output Port > RF4 1|O

Command:
[ :SENSe] : HDUPlex: PORT:OUTPut RFIO4

e This does not complete the port setup; two more settings are
required!
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Set up the RF Input using this menu setting or its equivalent command:
Input/Output > RF Input > RF Input Port > RF Input

Command:
:FEED:RF:PORT RFIN

Set up the RF Output using this menu setting or its equivalent command:
Input/Output > More > RF Output & Test Set Config > RF Output Port > RF Output

Command:
:FEED:RF: PORT:OUTP RFO
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Ports

OQutput | RF3 11O

RFIO 1

RFIO 2

Input RF4 1|O

F 3

4

F

h 4

L

F 3

SPLITTER/
COMBINER

SPLITTER/
COMBINER

F

Y

— From
Source

ala

L 4

e

v

v

v

To
Analyzer

To define RF4 1|0 as an input and RF3 1|0 as an output, use the following steps.

Define RF4 1|0 as an input, using this menu setting or its equivalent command:

Input/Output > More > RF Output & Test Set Config > Half Duplex Config >
RF Input Port > RF4 1|0

Command:
:HDUPlex:PORT: INPut RFIO4

Define RF3 1|0 as an output, using this menu setting or its equivalent command:

Input/Output > More > RF Output & Test Set Config > Half Duplex Config > RF
Output Port > RF3 1|O

Command:

[:SENSe] :HDUPlex:PORT:OUTPut RFIO3

56
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Set up the RF Input using this menu setting or its equivalent command:
Input/Output > RF Input > RF Input Port > RF Input

Command:
:FEED:RF:PORT RFIN

Set up the RF Output using this menu setting or its equivalent command:
Input/Output > More > RF Output & Test Set Config > RF Output Port > RF Output

Command:
:FEED:RF: PORT:OUTP RFO
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Separate Input and Output Port Setup (RFIO 1 and RFIO 2)

Although Ports RFIO 1 and RFIO 2 are designed to operate as full-duplex ports,
they can function as separate inputs and outputs.

Ports
/ X *
RF310 |« > .
[ From
—————
e Source
Input RFIO 1 »| SPLITTER/ |« .
COMBINER
SPLITTER/ |«
Output | RFIO2 |« COMBINER i
1. To
¢ al e Analyzer
RF41I0 [ il "

To use the RFIO 1 port as the input and the RFIO 2 port as the output, set up the
RF Input using this menu setting or its equivalent command:

Input/Output > RF Input > RF Input Port > RFIO 1

Command:
:FEED:RF:PORT RFIO1

Then set up the RF Output using this menu setting or its equivalent command:
Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 2

Command:
:FEED:RF: PORT : OUTP RFIO2
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Ports
RF3110 [—> s .
N \_ , From
o Source
Qutput RFIO 1 + SPLITTER/ |« ®
COMBINER
SPLITTER/ |e
Input RFIO 2 #| COMBINER n—
ot . Analyzer
REAIO | 1 ~ NP Y
- : *

To use the RFIO 1 port as the input and the RFIO 2 port as the output, set up the
RF Input using this menu setting or its equivalent command:

Input/Output > RF Input > RF Input Port > RFIO 2

Command:
:FEED:RF:PORT RFIO2

Then set up the RF Output using this menu setting or its equivalent command:
Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 1

Command:
:FEED:RF: PORT :OUTP RFIO1
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Option 4FD: Full Duplex Port Setup

Input/
Output

If the test set was purchased with Option 4FD, then each of the |0 ports connects
to a splitter/combiner rather than a switch, and it can be used in full duplex mode,
as a simultaneous input and output. In the example illustrated below, the RFIO 2
port is used in this way. (Other ports could be selected simply by substituting

different port names in the instructions provided below.)

Ports
SPLITTER/
RFIO 1  *— comBINER
RFIO2 |«—»| SPLITTER/
COMBINER
SPLITTER/ |4
RFIO3  *—* comBINER 8
SPLITTER/ | L— &
RFIO4 < ~ouBINER

<« From
Source

To
Analyzer

To use the RFIO 2 port as the input and output, set up the RF Input using this

menu setting or its equivalent command:

Input/Output > RF Input > RF Input Port > RFIO 2

Command:

:FEED:RF:PORT RFIO2

Then set up the RF Output using this menu setting or its equivalent command:

Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 2

Command:
:FEED:RF: PORT : OUTP RFIO2
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Option 4FD: Separate Input and Output Port Setup

Although, with Option 4FD, all of the RFIO ports are designed to operate as
full-duplex ports, they can function as separate inputs and outputs. In this
example, the RFIO 2 port is used as an input, and the RFIO 3 port as an output.
(Other port combinations could be selected simply by substituting different port
names in the instructions provided below.)

Ports
SPLITTER/ |* *
RFIOT <> comBINER >
e From
> Source
Input RFIO 2 » SPLITTER/ |« 5
COMBINER
_ SPLITTER/ |¢——
Dutput RFIO 3 - COMBINER —a
Sy
y To
SPLITTER/ | L la | ” Analyzer
RFIO4 > coupineR
—8

To use the RFIO 2 port as the input and the RFIO 3 port as the output, set up the
RF Input using this menu setting or its equivalent command:

Input/Output > RF Input > RF Input Port > RFIO 2

Command:
:FEED:RF: PORT RFIO2

Then set up RFIO 3 as the RF Output, using this menu setting or its equivalent
command:

Input/Output > More > RF Output & Test Set Config > RF Output Port > RFIO 3

Command:
:FEED:RF: PORT : OUTP RFIO3
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LAN Address Configuration

62

The E6640A supports both dynamic and static assignment of its IP address, using
ports LAN T and LAN 2 respectively.

The LAN 1 port is designed for dynamic IP addressing, using the Dynamic Host
Configuration Protocol. If the your site network supports DHCP, the E6640A will be
assigned an IP address automatically when it is connected to the LAN. Once the
address is assigned, it is listed, along with the computer name, under System >
Show > System. The address or computer name can be used to find the test set on
the LAN. However, to see the System > Show > System screen and find this
information, it is necessary either to connect a monitor to the front panel monitor
port, or else to use the LAN 2 port to connect test set to a PC directly.

Revision Date 1/7/2014 2:00:46 PM

Caormnputer System Windows 7, Service Pack 1

Computer Nams A-EBG404-01111

IP Address 148.5.97.84

|Pv6 Address 2001:0:5ef5:791d: 380c:3239:6bfa: Seab

Link-Local IPv6 Address  fe80:380c:3239:6bfa:9eab%3

Host 1D PCSERNO,GA47677499

mONS Enabled Tes

mOMS Host Name A-EG6404-0111-2

mONS Service Name Adilent PCSERNO YWireless Connectivity Test Set- SC29.

Using the LAN T port to connect the test set directly to the public LAN is
potentially insecure, because the test set does not provide anti-virus protection.
Connecting the test set to the public LAN by way of a PC with antivirus protection
is the preferred solution.

The LAN 2 port is designed to use a private static IP address, 192.168.1.2
(changing this address is possible but not recommended). This port can be used
for direct connection to a PC.

To find the test set on the LAN, you will need to know its IP address or computer
name. If you cannot easily obtain a monitor view of System > Show > System, you
can determine the computer name using the instrument serial number. The
computer name is in the format A-E6640A-nnnnn, ending in the last five digits of
the serial number.
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Switched MIMO

For WLAN modulation accuracy measurements, a form of MIMO measurement can
be made with a single TRX, using a time-division multiplexing process. The same
source/analyzer pair within the TRX switches between the antenna ports of the

Device Under Test.

In contrast to true MIMO functionality, which is available in WLAN mode but not in
Sequence Analyzer mode, the switched MIMO feature is a WLAN measurement
which is available only in Sequence Analyzer mode.

Constraints on Radio Standards

Only certain radio standards support MIMO. Under Mode Setup > Radio Std, select
802.11n or 802.11ac.

MIMO Port Configuration

For 2x2 MIMO , the RFIO 1 port (a full-duplex port) captures the data stream from
the first antenna port of the DUT. The other full-duplex port, RFIO 2, captures the
data stream from the second antenna port of the DUT.

2X2 Switched MIMO

> » RFIO 1 full duplex | analyzer
£ 2 | » RFIO 2 full duplex | analyzer
o
o
3]
c
<
]
é 3 RF3 1|O half duplex
4 RF4 1|0 half duplex
DUT TRX in Test Set

(Mobile Device)
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For 3x3 MIMO , the RFIO 1 port (a full-duplex port) captures the data stream from
the first antenna port of the DUT. The other full-duplex port, RFIO 2, captures the
data stream from the second antenna port of the DUT. One of the half-duplex
ports, RF3 1|0 or RF4 1|0, captures the data stream from the third antenna port of
the DUT.

3X3 Switched MIMO

Tle » RFIO 1 full duplex | analyzer
2 2} »| RFIO 2 full duplex | analyzer
o
o
1]
=
c
]
5 3 |« » RF3 I|O half duplex | analyzer
4 RF4 1|0 half duplex
DUT TRX in Test Set

(Mobile Device)

Source Sync Control

Switched MIMO is a measurement process only; it is not necessary to use Source
Sync Control (required for true MIMO) in the case of switched MIMO.

RF Input Port Mode

The RF Input Port Mode must be set to List, so that the sequence can change the
input port path from one acquisition to the next. In the Meas Setup > RF Input Port
Mode menu, select List. The equivalent SCPI commands is:

[:SENSe] : LSEQuencer : PORT: INPut :MODE LIST

Half Duplex RF Input

In the case of 3x3 switched MIMO, one of the half-duplex ports (RF3 1|0 or RF4 1|0)
must be designated as an RF input port for the third input. In the Input/Output >
RF Output & Test Set Config > Half Duplex Config > RF Input menu, select RFIO3
or RFI04, so that the RF3 10 port or the RF4 1|0 port is defined as the input port.
The equivalent SCPI command is:

[:SENSe] :HDUPlex:PORT: INPut RFIO3|RFIO4
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Triggers

Each of the acquisitions which make up a sequence used for switched MIMO
testing needs to have the same trigger settings as the others.

Integration

For 2x2 switched MIMO in Sequence Analyzer mode, two separate acquisitions are
used for the two separate ports, and must be integrated. Set up acquisition
integration as follows: in the Meas Setup > Acquisition Setup > Acquisition
Integration menu, select Primary for the first acquisition and Switch MIMO for the
second. The equivalent SCPI commands are:

[:SENSe] : LSEQuencer:ACQuire{1:512}:SETup: INTegration PRIMary
[:SENSe] : LSEQuencer:ACQuire{1:512}:SETup: INTegration SMIMo

For 3x3 switched MIMO in Sequence Analyzer mode, three separate acquisitions
are used for the three separate ports, and must be integrated. Set up acquisition
integration as follows: in the Meas Setup > Acquisition Setup > Acquisition
Integration menu, select Primary for the first acquisition and Switch MIMO for the
second and third. The equivalent SCPI commands are:

[:SENSe] : LSEQuencer:ACQuire{1:512}:SETup: INTegration PRIMary
[:SENSe] :LSEQuencer:ACQuire{1:512}:SETup: INTegration SMIMo
[:SENSe] : LSEQuencer:ACQuire{1:512}:SETup: INTegration SMIMo

The integration parameter can also be set within the complex
command which is used to set the Acquisition RF Input Port
(see “Acquisition RF Input Port" on page 66; the integration
parameter is the one which comes immediately before the
Acquisition RF Input Port parameter.

NOTE
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Acquisition RF Input Port

An RF input path must be selected for each acquisition. In the Meas Setup >
Acquisition Setup > Acquisition RF Input Port menu, select RFIO1, RFIO2, or RF
Input, as needed for each acquisition. The RF Input selection, which is used for the
third port in 3x3 switched MIMO, means that whichever of the half-duplex ports
(RF3 1|0 or RF4 1|0) has been designated as the RF input is used (see “Half Duplex
RF Input" on page 64). In SCPI, the acquisition RF input port is controlled by the
last parameter in the complex command which configures the acquisition (the
values for the relevant parameter are italicized here):

[:SENSe] : LSEQuencer:ACQuire[1] |2]...|4..512:SETup

NONE | GSM | EDGE | WCDMA | CDMA2K | CDMA1XEV | LTE | LTETDD |
TDSCDMA | BTooth | WLAN,

NONE | PGSM | EGSM | RGSM | DCS1800 | PCS1900 | TGSM810 | GSM450
| GSM480 | GSM850 | GSM700 | BANDI | BANDII | BANDIII | BANDIV |
BANDV | BANDVI | BANDVII | BANDVIII | BANDIX | BANDX | BANDXI |
BANDXII | BANDXIII | BANDXIV | USCELL | USPCS | JAPAN | KOREAN |
NMT | IMT2K | UPPER | SECOND | PAMR400 | PAMR8S80OO | IMTEXT |
PCS1DOT9G | AWS | US2DOT5G | PUBLIC | LOWER | BAND1 | BAND2 |
BAND3 | BAND4 | BAND5 | BAND6 | BAND7 | BANDS | BANDY | BAND1O |

BAND11 | BAND12 | BAND13 | BAND14 | BAND17 | BAND18 | BAND19 |
BAND20 | BAND21 | BAND24 | BAND25 | BAND26 | BAND27 | BAND28 |
BAND31 | BAND33 | BAND34 | BAND35 | BAND36 | BAND37 | BAND38 |
BAND39 | BAND40 | BAND41 | BAND42 | BAND43 | BAND44 | BANDA |

BANDB | BANDC | BANDD | BANDE | BANDF,

BTS | MS,

<real>, <integer>, <ampls>,

LOW | ZERO | HIGH,

<time>, <times>,

IMMediate | VIDeo | Video2 | INTernal | EXT1 | EXT2,
<amptd>, <times,

NONE | INT/,

<relative ampls>,

OFF | RFIOO | RFIO1 | RFIO2 | RFIO3 | RFIO4 | RFIOS | RFIO6 |
RFIO7,

ON | OFF,

NORMal | PRIMary | LOWer | UPPer | RANGe | SMIMo,
RFIO1 | RFIO2 | RFIN | RFIO3 | RFIO4

In the Acquisition RF Input Port parameter (italicized above),
the values RFIO3 and RFIO4 apply only if the test set has
Option 4FD. The parameter immediately preceding that one is
the Acquisition Integration parameter, and can be set to
PRIMary or SMIMo as needed (see “Acquisition Integration" on
page 65).
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Switched MIMO Modulation Accuracy measurement SCPI commands

3

The following commands are used to set up the MIMO Modulation Accuracy (“EVM
MIMO”) measurement.

Command Description Notes
:CALCulate:LSEQuencer :WLAN: EVMMimo:LIMit: Freq Error Sets a frequency
FERRor <reals> error limit
:CALCulate:LSEQuencer : WLAN : EVMMimo: LIMit : Clock Error Sets a clock error

CLKerror <real>

limit

:CALCulate:LSEQuencer:

CFLeakage <rel ampl>

WLAN : EVMMimo: LIMit:

Center Freq Leakage

Sets Center Freq
Leakage limit

:CALCulate:LSEQuencer:

CFLeakage <rel ampl>

WLAN : EVMMimo: LIMit:

BPSK-1/2 RMS EVM

Sets BPSK coding
rate 1/2 RMS EVM
limit

:CALCulate:LSEQuencer:

BPSK:R1B2 <rel ampls>

WLAN: EVMMimo: LIMit :

QPSK-1/2 RMS EVM

Sets QPSK coding
rate 1/2 RMS EVM
limit

:CALCulate:LSEQuencer:

WLAN : EVMMimo: LIMit:

QPSK-3/4 RMS EVM

Sets QPSK coding

QPSK:R1B2 <rel ampls rate 3/4 RMS EVM
limit
:CALCulate:LSEQuencer :WLAN : EVMMimo : LIMit : RMS: 16QAM-1/2 RMS Sets 16QAM
QPSK:R3B4 <rel ampl> EVM coding rate 1/2
RMS EVM limit
:CALCulate:LSEQuencer :WLAN: EVMMimo: LIMit : RMS: 16QAM-3/4 RMS Sets 16QAM
QA16:R1B2 <rel ampls EVM coding rate 3/4
RMS EVM limit
:CALCulate :LSEQuencer :WLAN: EVMMimo: LIMit : RMS: 640AM-2/3 RMS Sets 64QAM
QA16:R3B4 <rel ampls> EVM coding rate 2/3
RMS EVM limit
:CALCulate:LSEQuencer : WLAN : EVMMimo : LIMit : RMS: 640AM-3/4 RMS Sets 64Q0AM
QA64:R2B3 <rel ampls EVM coding rate 3/4
RMS EVM limit
:CALCulate:LSEQuencer :WLAN: EVMMimo: LIMit : RMS: 64QAM-5/6 RMS Sets 64QAM
QA64:R5B6 <rel ampls EVM coding rate 5/6
RMS EVM limit
:CALCulate :LSEQuencer :WLAN: EVMMimo: LIMit : RMS: 256QAM-3/4 RMS Sets 256QAM
QA256:R3B4 <rel ampls> EVM coding rate 3/4
RMS EVM limit
:CALCulate:LSEQuencer : WLAN: EVMMimo: LIMit :RMS: 256QAM-5/6 RMS Sets 256QAM
QA256:R5B6 <rel ampls> EVM coding rate 5/6

RMS EVM limit
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Command Description Notes
:CALCulate:LSEQuencer :WLAN: EVMMimo : EQUalizer: Equalizer Training Specifies how the
TMODe SEQuence | SDATa equalizer is
initialized or
trained.
:CALCulate:LSEQuencer :WLAN: EVMMimo: PILot : TRACk:  Track Amplitude Sspecifies whether
AMPLitude OFF|ON|O0|1 analyzer tracks
amplitude changes
in the pilot
subcarriers.
:CALCulate:LSEQuencer :WLAN: EVMMimo: PILot : TRACk:  Track Phase Specifies whether
PHASe OFF|ON|O|1 analyzer tracks
phase changes in
the pilot
subcarriers.
:CALCulate:LSEQuencer :WLAN: EVMMimo: PILot : TRACk:  Track Timing Specifies whether
TIMing OFF|ON|0|1 analyzer tracks
timing changes in
the pilot
subcarriers.

:CALCulate:LSEQuencer : WLAN : EVMMimo
MODE POSTeq|PREegq

:PILot : TRACK:

Pilot Tracking Mode

Specifies the Pilot
Tracking Mode. The
valid values are
Post EQ and Pre
EQ.

[ :SENSe] :LSEQuencer : WLAN : EVMMimo:
MTYPe DMAP|FOURier

Matrix Type

Specifies MIMO
matrix type.

68
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Switched MIMO Results

The results available for a WLAN MIMO Modulation Accuracy measurement are as
follows (the results for Stream 3 are returned as -1.0 (not tested) in the case of 2x2

MIMO):
Index Result Parameter
0 Overall Pass/Fail Result

0:Pass, 1:Fail, -1:Not tested

1 Stream 1 RMS EVM pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)

2 Stream 1 RMS EVM (dB)

3 Stream 1 Peak EVM (dB)

4 Stream 1 Pilot EVM (dB)

5 Stream 1 Data EVM (dB)

6 Stream 1 Chips Peak EVM (%)

7-18 7-12: Stream 2 (as in Index 1-6 above). 13-18: Stream 3 (as in Index 1-6 above)

19-24 Reserved

25 Channel T RMS EVM pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)

26 Channel 1 Frequency Error pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)
27 Channel 1 Symbol Clock Error pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)
28 Channel 1 1Q Offset pass/fail result (1.0 = fail, 0.0 = pass, -1.0 = Not tested)

29 Channel 1 RMS EVM (dB)

30 Channel 1 Peak EVM (dB)

31 Channel 1 Pilot EVM (dB)

32 Channel 1 Data EVM (dB)

33 Channel 1 Frequency Error (Hz)

34 Channel 1 Symbol Clock Error (ppm)

35 Channel 1 1Q Gain Imblance (dB)

36 Channel 11Q Offset (dB)

37 Channel 1 1Q Quadrature Error (deg)

38 Channel 1 1Q Timing Skew (pps)

39 Channel 1 Cross Power (dB)

40 Channel 1 Sync Corr
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Index Result Parameter

41-72 41-56: Channel 2 (as in Index 25-40 above). 57-72: Channel 3 (as in Index 25-40 above)
73-88 Reserved
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True MIMO

In WLAN mode, True MIMO (simultaneous rather than switched MIMO) is
supported for the MIMO Modulation Analysis measurement. (This functionality is
not available in Sequence Analyzer mode.) Setting up this type of measurement
requires configuration of two separate TRXs.

For MIMO Modulation Analysis, two or more measurement data streams are
captured simultaneously, by two or more separate TRXs in the EXM test set. In the
EXM, the TRXs share a common frequency reference. They also share a common [P
address, but have separate socket numbers. In MIMO testing, a single TRX is
designated the primary, and it controls the other TRX or TRXs used.

TRX Configurations
Here is an example of 2x2 MIMO:

RFIO 1§
’ full duplex‘ih TRX 1 (primary) _ analyzer
) i i [TCPIPO: :<IP Addr>::| i & source
t i |  5025::s0ckET :
o : ¢
m : :
c ; :
& : H
£ RFIO 1 } |
c i TRX 2 (seconda :
€ [ pery ICEIPC-::({IP A:u?:}x:: i analyzer
I i'| 5125::S0CKE i & source
]
DUT
Test Set

(Mobile Device)

In the example setup shown here, TRX 1 runs the MIMO Modulation Analysis
measurement, and is also configured to control TRX 2, which collects the second
data stream. The primary TRX controls the measurement settings for the
secondary TRX, and also processes the measurement data collected by the
secondary. (The display window for the secondary will display a mostly-blank
screen, with a message indicating that it is in use by the primary.)
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Here is an example of 3x3 MIMO:

RFIO 1 : i

i TRX 1 (primary) i

full duplex i i
i 1 je P | TCPIPO: :<IP Addr>::| i znaEyzer
= 5025: : SOCKET [ & S0Urce

s :

o RFIO 1 |
p= full duplex | TRX 2 ¢ analyzer
- 2 | TCPIPO: :<IP Addr>:{ i & source

= 5125 : : SOCKET

- 2

e RFIO1 i
< full duplex i TRX 3 i analyzer
3 e I TCPIPO: :<IP Addr>::| i @ oniirce

i 5225::SOCKET

DUT TRXs in Test Set

(Mobile Device)

In the example setup shown here, TRX 1 runs the MIMO Modulation Analysis
measurement, and is also configured to control TRX 2 and 3, which collect the
second and third data streams.

Here is an example of 4x4 MIMO:

RFIO1 | :
: TRX 1 (primary) i
full duplex : i
1|« B iyl TCPTPO: :<IP Addr>:: gnaiyzer
! 5025: : SOCKET |, SROUGS
RFIO 1 : :
& ) full duplex | TRX 2 i analyzer
6 2 | TCPIPO: :<IP Addr>:q i o o o
o : 5125: : SOCKET u
8 RFIO1 |
E 3 e full duplex if TE;‘SAM _ | i analyzer
- Hea RS L8 B r=-:1: :
é 5225: : SOCKET : &source
RFIO1 :
n full duplex EPI . TRdeAdd i analyzer
+ TP TCEIRO: 1< ddr>::| ¢
i 5325: : SOCKET & source
R e e e e i
DUT TRXs in Test Set

(Mobile Device)

In the example setup shown here, TRX 1 runs the MIMO Modulation Analysis
measurement, and is also configured to control TRX 2 to 4, which collect the
second, third, and fourth data streams.
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Source Settings for MIMO

Unlike measurement settings, which are made only to the primary TRX and applied
to the others, source settings can be made separately for each TRX. However, it is
possible to make certain source settings to other TRXs by making them to the
primary TRX. Also, when the measurement is run, the primary TRX communicates
with the other TRXs to ensure that they begin playing ARB files simultaneously.

To run the sources synchronously:

1.

If there are any source settings which you don’t plan to make by way of the
primary TRX, begin by making them individually on each TRX which will be
used in the MIMO test.

2. Select the source synchronization type on the primary TRX which will be used

3.
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in the MIMO test:

For 2x2 MIMO, set up source synchronization as follows: in the Source >
Source Sync Control menu, select 2x2. Do this for both TRXs. The
equivalent SCPI command is:

: SOURce : SYNC: CONFig TWO

For 3x3 MIMO, set up source synchronization as follows: in the Source >
Source Sync Control menu, select 3x3. Do this for all three TRXs. The
equivalent SCPI command is:

: SOURce : SYNC: CONFig THRee

For 4x4 MIMO, set up source synchronization as follows: in the Source >
Source Sync Control menu, select 4x4. Do this for all four TRXs. The
equivalent SCPI command is:

: SOURce : SYNC: CONFig FOUR

For 2x2 + 2x2 MIMO, set up source synchronization as follows: in the Source
> Source Sync Control menu, select 2x2+2x2. Do this for all four TRXs. The
equivalent SCPI command is:

: SOURce : SYNC: CONFig DTWO

For 1x1 + 1x1 MIMO, set up source synchronization as follows: in the Source
> Source Sync Control menu, select 1x1+1x1. Do this for all four TRXs. The
equivalent SCPI command is:

: SOURce : SYNC: CONFig DONE

In the window for the primary TRX, go to the Source > Source Sync Control >
Sync Settings Setup menu and press Sync Settings [On]. With this feature
enabled, certain settings for the primary TRX source (frequency, amplitude,
waveform, trigger source, trigger type, and RF output) are also applied to the
other TRX sources. The equivalent SCPI command is:

:SOURce : SYNC: SETT: ENAB ON
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4. For 1x1 + 1xT MIMO or 2x2 + 2x2 MIMO, go to the Source > Source Sync

Control > Sync Settings Setup > Segment 2 Setup menu and press Sync
Segment 2 [On]. With this feature enabled, certain non-frequency settings for
the primary TRX source (amplitude, waveform, trigger source, trigger type, and
RF output) are also applied to the second of two “2x2 + 2x2” or “Ix1 + 1x1”
pairs of TRXs. The equivalent SCPI command is:

:SOUR: SYNC:SETT : SEGM2 : ENAB ON

. For 1x1 + 1x1 MIMO or 2x2 + 2x2 MIMO, go to the Source > Source Sync

Control > Sync Settings Setup > Segment 2 Setup menu and press Segment 2
Frequency. With this feature enabled, a specified frequency setting can be
applied to the second of two “2x2 + 2x2” or “1x1 + 1x1” pairs of TRXs. This is
necessary if the desired frequency is anything other than the default value of 1
GHz. An example of the equivalent SCPI command is:

:SOUR : SYNC: SETT: SEGM2 : FREQ 2.00 GHz

. Inthe window for the primary TRX, activate synchronization in the Source >

Source Sync Control menu by pressing Sync Start. At this point, the other TRX
sources are synchronized to the primary and will play their arb files
simultaneously with it. The equivalent SCPlI command is:

:SOUR: SYNC: STARt

You can stop synchronization in the Source > Source Sync Control menu by
pressing Sync Stop. The equivalent SCPI command is:

: SOURce : SYNC: STOP

When Sync Settings is enabled, the naming of waveform files
used by the sources must be coordinated; see “Constraints on
Waveform File Names" on page 75.
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Constraints on Waveform File Names

When Sync Settings is enabled, as described in the previous procedure, it is
necessary to follow a convention for naming the waveform files used by the TRXs,
so that the file associated with each TRX is distinguished by a TRX-specific suffix.
The table below lists the suffixes for each MIMO configuration. Note that the
convention for the 4X4 configuration is not the same as the convention for a pair of
2X2 configurations.

MIMO Configuration = TRX Numbers Equivalent Waveform File Names
(“.xxx” can be .wfm, .bin, or .seq)
2x2 TRX 1 or TRX3 <name>0.xxx
TRX 2 or TRX4 <name>1.xxx
3x3 TRX 1 <name>0.xxx
TRX 2 <name>1.xxx
TRX 3 <name>2.Xxx
4x4 TRX 1 <name>0.xxx
TRX 2 <name>1.xxx
TRX 3 <name>2.Xxx
TRX 4 <name>3.Xxx
2x2 + 2x2 TRX 1 <name>0_0.xxx
TRX 2 <name>0_1.xxx
TRX 3 <name>1_0.xxx
TRX 4 <name>1_1.xxx
1x1 + 1x1 TRX1 or TRX3 <name>0_0.xxx
TRX2 or TRX4 <name>1_0.xxx

Constraints on TRX Selection

Not every TRX can be designated the primary for purposes of MIMO testing. The
permitted configurations are:

MIMO Configuration  Primary TRX Secondary TRXs
2x2 TRX 1 TRX 2, Socket 5125
2x2 (alternative setup) TRX 3 TRX 4, Socket 5325
3x3 TRX1 TRX 2, Socket 5125

TRX 3, Socket 5225

4x4 TRX 1 TRX 2, Socket 5125
TRX 3, Socket 5225
TRX 4, Socket 5325
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Constraints on Radio Standards

Only certain radio standards support MIMO. Under Mode Setup > Radio Std, select
802.11n or 802.11ac.

MIMO Type

For the MIMO Modulation Analysis measurement, go to the Meas Setup > MIMO
Type menu and select 2x2, 3x3, or 4x4.This setting determines whether the display
shows two, three, or four constellation diagrams for the measurement.) The
equivalent SCPI command is:

[:SENSe] :EVMMimo: TYPe M2M2 |M3M3 |M4M4

Remote Analyzer Configuration

This feature is used to coordinate TRXs within the test set; it is named this way
because its original purpose was to coordinate the test set with external
equipment.

The MIMO configuration that is set up here needs to match the
MIMO Type selection, as described above. Error messages will
be displayed until the two are in agreement.

NOTE

1. From the primary TRX window (TRX 1 in this example), select Mode Setup >
Global Settings > Remote Analyzer Config.

2. Alistis displayed which includes any TRX which you have previously used
(unless you have deleted it) and any added while in the Add Analyzer to List
menu. However, the list may be blank, or may not include the desired TRX.

3. To add a TRX to the list, press Add Analyzer to List.

4. Click IP Address, use the numeric keys to enter an IP address for the test set,
and press Enter. In this example, the test set’s localhost address is used (for the
EXM test set, the localhost address has a fixed value of 127.0.0.1).

5. Click SCPI Socket Port, use the numeric keys to enter the socket number of the
secondary TRX, and press Enter. In this example socket number 5125 (TRX 2) is
used.

6. Press Add. The secondary TRX is now displayed in the list.

7. Select the desired TRX from the displayed list (use the up and down arrow keys
to move the highlighted selection to the desired TRX and then press Select
Highlighted Analyzer).

8. The secondary TRX is now being run from the present TRX. The window for the
secondary TRX displays a “This instrument is in use...” message. If you need to
release it from control, go to the primary TRX and select Mode Setup > Global
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Settings > Remote Analyzer Config > Release Current Analyzer, or send to the
primary the equivalent SCPI command:
:SYST:COMM: ANAL: REL

9. The equivalent SCPI command for the steps described above is as follows
(modify the address string "127.0.0.1:5125" as needed):
:SYST:COMM:ANAL:SEL "127.0.0.1:5125"

i - External Clignt Access - Rermote Signal Analyzer (TRx 2) L= ‘ =2

This instrument is in use by the Signal Analyzerrunning on host A- Remote
E6640-00099.

To unlock the front panel and allow you to resume local operation, either shut
down that application, or disconnect it from this instrument using the Mode
Setup->Select Remote Analyzer->Release Current Analyzer softkey in the
master or send ":SYSTem:COMMunicate:ANALyzer-REL ease" to the master.

TRXL IWLAN - Channel Power

RFIOL 509  AC | SENSE:INT] RF OFF [ /WALIGN OFF [ 10:52:22 am Jul08, 2014

Center Freq: 2.412000000 GHz Radio Std: 11alg
() Trig: Free Run Avg|Hold:=>10M10 Mod Format: AUTO
; Range: 0 dBm Guard Intvl: 1/4
1. Select the desired analyzer from the remote analyzer list. Use the up and down arrow keys to move the highlighted selection to the
desired analyzer and then press "Select Highlighted Analyzer”
2. The remote analyzer list includes any analyzer which you have previously used (unless you have deleted them) and any added while
in the "Add Analyzer to List" menu.
3. To add an analyzer (which you will need to do before you can use a multi-analyzer measurement), press "Add Analyzer to List" and
enter the IP Address then press "Add". If a supported analyzer is found at that address, it will be added to the list
4. At any time you may use the "Verify Highlighted Analyzer". "Delete Highlighted Analyzer" or "Delete All Analyzers” keys to verify
the interface connection to the Highlighted Analyzer, delete the Highlighted Analyzer from the remote analyzer list or clear the
remote analyzer list
5. The maximum number of analyzers in the list is 10. If 10 analyzers already exist in the list, the "Add Analyzer to List" softkey will be
grayed out
6. The "Cument Analyzer" area indicates which one in the remote analyzer list is selected and its information.

Ch  Selected Werified P Paort “IDN?

2 | ves | ves | 127001 5125  EG640A.US53300099.E.14.34

The procedure given above is for 2x2 MIMO; the process is the same for 3x3 or 4x4
MIMO, except that more TRXs are added.

The command equivalent for 3x3 MIMO would be:
:SYST:COMM:ANAL:SEL "127.0.0.1:5125"
:SYST:COMM:ANAL:SEL "127.0.0.1:5225"

The command equivalent for 4x4 MIMO would be:
:SYST:COMM:ANAL:SEL "127.0.0.1:5125"
:SYST:COMM:ANAL:SEL "127.0.0.1:5225"
:SYST:COMM:ANAL:SEL "127.0.0.1:5325"
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MIMO Modulation Analysis measurement SCPI commands

The following commands are used to set up the MIMO Modulation Analysis

measurement.
Command Description Notes
[:SENSe] : EVMMimo :MTYPe DMAP|FOURier Matrix Type Sets the type as
DMAP or Fourier
[:SENSe] : EVMMimo: TYPe M2M2 |M3M3 |M4M4 MIMO Type Sets the type as
2x2, 3x3, or 4x4
[:SENSe] :EVMMimo:RESult :STReam <integer> MIMO Result Stream  Specifies the result
Index stream by number.
[:SENSe] :EVMMimo:RESult:CHANnel <integers MIMO Result Specifies the result
Channel Index channel by number.
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MIMO Modulation Analysis Results

3

The results available for a WLAN MIMO Modulation Analysis measurement are as
follows (the results for Stream 3 are returned as -1.0 (not tested) in the case of 2x2

MIMO):

0 Returns unprocessed I/Q trace data of Capture Interval, as a series of trace point values for Channel m.
Channel index m can be set and queried through EVMM:RESult:CHAN command.

The I values are listed first in each pair, using the 0 through even-indexed values. The Q values are the
odd-indexed values.

1 Returns the comma-separated EVM results by stream. The EVM scalar results for each stream are in the
following order:

1. RMS EVM Max (dB)

2. RMS EVM Avg (dB)

3. Peak EVM Max (dB)

4. Peak EVM Avg (dB)

5. Pilot EVM Max (dB)

6. Pilot EVM Avg (dB)

7. Data EVM Max (dB)

8. Data EVM Avg (dB)

9. CPE EVM Max (dB)

10. CPE EVM Avg (dB)

When MIMO Type is 2x2, this result gives stream 1 EVM scalar results first, then stream 2 EVM scalar results.
When MIMO Type is 3x3, stream 1, 2 and 3 EVM scalar results are provided in order. When MIMO Type is 4x4,
returns 40 comma-separated EVM scalar results, provided in stream order.

2 Returns a value of the pass/fail (0.0 = passed, or 1.0 = failed) results determined by testing the result of RMS
EVM. Only when all the stream RMS EVM Average results are passed, will this value be passed.

3 Returns series of floating point numbers that alternately represent | and Q pairs of the corrected measured
trace for STRM m. Stream index m can be set and queried through EVMM:RESult:STReam command.

The magnitude of each | and @ pair are normalized to 1.0, when the IQ Normalize is turned on. The first
number is the in-phase (I) sample and the second is the quadrature-phase (Q) sample.

4 Returns series of floating point numbers (in dB) that represent each sample in the Stream EVM vs. Carrier
trace of Capture Interval for STRM m. Stream index m can be set and queried through EVMM:RESult:STReam
command.

5 Returns series of floating point numbers (in dB) that represent each sample in the Stream EVM vs. Symbol

trace of Capture Interval for STRM m. The first number is the symbol 0 decision point. Stream index m can be
set and queried through EVMM:RESult:STReam command.
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Index Result Parameter

6 Returns series of floating point numbers that represent each sample in the Channel Response for STRM m CH
k. Stream index m can be set and queried through EVMM:RESult:STReam command. Channel index k can be
set and queried through EVMM:RESult:CHAN command.

7 Returns comma-separated EVM scalar results by channel. The EVM scalar results for each channel are in the
following order:

. RMS EVM Max (dB)

.RMS EVM Avg (dB)

. Peak EVM Max (dB)

. Peak EVM Avg (dB)

5. Pilot EVM Max (dB)

6. Pilot EVM Avg (dB)

7. Data EVM Max (dB)

8. Data EVM Avg (dB)

9. Freq Error Max (Hz)

10. Freq Error Avg (Hz)

11. Freq Error Ppm Max (ppm)
12. Freq Error Ppm Avg (ppm)
13. Sym Clock Error Max (ppm)
14. Sym Click Error Avg (ppm)
15. 1Q Gain Imb Max (dB)

16. 1Q Gain Imb Avg (dB)

17.1Q Offset Max (dB)

18. 1Q Offset Avg (dB)

19.1Q Quad Error Max (degree)
20. 1Q Quad Error Avg (degree)
21.1Q Timing Skew Max (s)
22.1Q Timing Skew Avg (s)

23. Cross Pwr Max (dB)

24. Cross Pwr Avg (db)

25. Sync Corr Max

26. Sync Corr Avg

27. Avg Burst Power Max (dBm)
28. Avg Burst Power Avg (dBm)
29. Peak Burst Power Max (dBm)
30. Peak Burst Power Avg (dBm)

W N =

N

When MIMO Type is 2x2, 60 comma-separated scalar results are returned;
When MIMO Type is 3x3, 90 comma-separated scalar results are returned;
When MIMO Type is 4x4, 120 comma-separated scalar results are returned.

8 Return the Channel Matrix results.
9 Return the decode bits of HT-SIG Signal.
10 Returns series of floating point numbers (in dB) that represent each sample in the Equalizer Impulse

Response for STRM m CH k. Stream index m can be set and queried through EVMM:RESult:STReam
command. Channel index k can be set and queried through EVMM:RESult:CHAN command.
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1 Returns comma-separated floating point numbers of spectral flatness trace for STRM m CH k. Stream index m
can be set and queried through EVMM:RESult:STReam command. Channel index k can be set and queried
through EVMM:RESult:CHAN command.

12 Returns Data Rate (in Mbps) for MIMO input signals.

13 Returns the FFT SEM trace consisting of 5001 points if SEM is activated for Ch k. Chan index k can be set and
queried through through EVMM:RESult:CHAN command.

14 Returns the SEM failed information consisting of ( 2(DeltaFreq,DeltaAmplitude) x 6(OffsetA Lower, OffsetA
Upper, OffsetB Lower, OffsetB Upper, Offset C Lower, Offset C Upper)=12 values in upper and lower bands of
three offsets for Ch k. Chan index k can be set and queried through through EVMM:RESult:CHAN command.

: When MIMO Type is 2X2 and Radio Standard is 80+80 MHz, all
these measurement results are only for one segment. Use SCPI
command EVMM:RESult:SEGMent to specify that these
contents are the first segment results or the second segment
results.
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Tx Beam Forming

If license V9077B-KFP is installed, Tx Beam-Forming results are available from the
Modulation Analysis measurement in WLAN mode.

Tx Beam Forming Commands

Two commands are added for Tx Beam Forming, as described in the table below.
The first command sets up the measurement’s EVM demodulation algorithm to
provide EVM results or Tx Beam Forming Results. The second command is used to
specify the channel count of the measured MIMO signal.

Command Description

[:SENSe] :EVM:BFORming :MTYPe EVM|TXBFcal This command is only available when
license V9077B-KFP is installed; otherwise,
“-113, Undefined Header” error will be
reported.

This parameter takes effect when the Radio
Std is 802.11n(20MHz), 802.11n (40MHz),
802.11ac (20MHz), 802.11ac (40MHz),
802.11ac (80MHz) and 802.11ac (160MHz)

When EVM is selected, the result index
1~20 are calculated with meaningful values
for EVM measurement, and result 21 and 22
results are -999.0;

When TXBFcal is selected, the result index
1~20 values will not be calculated; Instead,
result 21 and 22 are calculated and
returned

[:SENSe] :EVM:ACCHannel <integer> <real> For Radio Std 802.11n (20MHz) and
802.11n (40MHz), Tx Beam Forming with
channel count <=4 is supported;

For Radio Std 802.11ac (20MHz), 802.11ac
(40MHz), 802.11ac (80MHz), and 802.11ac
(160MHz), Tx Beam Forming with channel
count <=8 is supported
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Tx Beam Forming Results

The Tx Beam Forming results are added to the Modulation Analysis measurement
results as Index 21 and Index 22, as described in the table below.

Index Result Parameter

21 Tx Beam Forming Calibrated Angle Error
returns a series of floating point numbers (in rad) that represent the calibrated angle error vectors on
channels, when

- Radio Std is 802.11n (20 MHz), or 802.11n (40 MHz), and MIMO Tx Channel Count <= 4

- Radio Std is 802.11ac(20MHz), 802.11ac(40MHz), 802.11ac(80MHz), or 802.11ac(160MHz), and MIMO Tx
Channel Count <=8

- MIMO Usage Type is TXBForming (available when license V9077B-KFP is installed)
Otherwise, returns -999.0.

The first channel angle vector is used as reference; the angle error vectors are listed in order of channels. For
the 20MHz BW signals, each channel’s angle error vector contains 64 values; For the 40MHz BW signals,
each channels angle error vector contains 128 values; For the 80MHz BW signals, each channels angle error
vector contains 256 values, For 160MHz BW signals, each channels angle error vector contains 512 values.

22 Tx Beam Forming Gain
returns gain after the calibrated angle error vector are compensated for the MIMO input signal, when

- Radio Std is 802.11n (20 MHz), or 802.11n (40 MHz), and MIMO Tx Channel Count <= 4

- Radio Std is 802.11ac(20MHz), 802.11ac(40MHz), 802.11ac(80MHz), or 802.11ac(160MHz), and MIMO Tx
Channel Count <=8

- MIMO Usage Type is TXBForming (available when license V9077B-KFP is installed)
Otherwise, returns -999.0.
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Keysight E6640A
EXM Wireless Test Set

Getting Started Guide

Test Set Operating System

KEYSIGHT

TECHNOLOGIES

This chapter describes the Microsoft Windows configuration and the settings used
with the Keysight test set software. It includes information about changing some of
the system settings. And it describes the Windows operating system configuration
and the software installations that are present on the hard disk drive when the test
set leaves the factory.

“Keysight Software Installed" on page 86
“Customer Installation of Software" on page 87
“User Accounts" on page 88

“Keysight Licensing Options" on page 90

“Licensing New Measurement Application Software - After Initial Purchase" on
page 92

“Windows Configuration" on page 97
“Configuring Printers" on page 100
“Configuring LAN" on page 100

“Windows Security" on page 101

“System Maintenance" on page 105

“USB Connections" on page 106

“Hard Drive Partitioning and Use" on page 107
“Hard Drive Recovery Process" on page 108

“Updating the software" on page 110
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Keysight Software Installed

86

Measurement Software Applications

A set of Keysight measurement applications for different modes (GSM/EDTE,
cdma2000, Sequence Analyzer mode, etc.) is installed by default in the test set,
but these must be licensed in order to be used. Whichever licenses were
purchased with the instrument are installed at the factory (see “Options and
Licenses" on page 21. Other licenses can be purchased and installed later
(including transportable licenses). For more information, see:
http://www.keysight.com/find/e6640a
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Customer Installation of Software

3rd party software verified by Keysight

Keysight has verified that the following programs are compatible with the test set
applications:

Symantec AntiVirus™ Corporate Edition version 10

MathWorks MATLAB

Installation of other 3rd party software

The E6640A platform is an open Windows environment, so you can install
non-approved software on the test set. However, installation of non-approved
software may affect test set performance. Keysight does not warrant the
performance of the test set with non-approved software installed.

Before installing any additional programs on the test set, you should exit the
test set application.

Also, you must not remove any applications or programs that are installed on
the test set when it is shipped from the factory.

If you install programs other than those that Keysight has tested, it could cause
problems with the test set's applications. If this happens, you should try
uninstalling the program that has caused the problem, or try changing the
program's configuration. If this does not correct the problem, you may have to use
the Keysight Recovery system to reinstall the test set's system software.
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Test Set Operating System

Administrator login

User login

The Administrator account ships from the factory with the password “Keysight4u!”
Using the Administrator account, you can perform the following operations:

Install software

Configure network and printer access

Access all files on the test set

Add or change user accounts and passwords

Change Firewall settings

Change Windows settings (for example, using Device Manager)
Change the time and date

Run any application

The E6640A was formerly a product of Agilent Technologies. If
the front panel of the test set shows Agilent as the
manufacturer, then “agilent4u” may have been set as the
password for the Administrator account.

The default user account that ships from the factory is “Instrument” with the
password “measure4u”. This user is a member of the Power Users group. Using the
Instrument account you can perform the following operations:

Install software

Configure network and printer access

Access files on the test set that are accessible to the Power Users group
Run applications that are accessible to the Power Users group

KeysightOnly user account

The test set contains a user account called “KeysightOnly” that can be used by
Keysight’s customer support in the event that the Administrator password was
changed and has since been lost or forgotten. You must not remove or modify the
KeysightOnly account. (If the front panel of the test set shows Agilent
Technologies as the manufacturer, the account may be called “AgilentOnly”.)

Keysight service user accounts

User accounts are defined for Keysight’s use if it is necessary to service the test
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Customer creation of accounts

You can create additional user accounts and decide on the level of security
granted to any new user accounts created. For example, the level of security can
be assigned as administrator, power user, user, backup operators. User names are
not case sensitive but passwords are case sensitive.

For the test set software to operate, the user account executing the software
must be assigned Administrator or Power User privileges. Otherwise, the test
set software will not operate correctly.

It is Keysight's expectation that each user’s My Documents folder is mapped to the
D: drive. This is to avoid overwriting the user’s data in the event the Keysight
Recovery must be performed. Also, this facilitates convenient backup by copying
the contents of the D: drive to external media. All users accounts created by the
factory already have My Documents mapped to the D: drive. Please map all new
users My Documents folders to the D: drive.
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Keysight Licensing Options

90

Keysight test sets use three licensing types: Fixed Perpetual, Transportable
Perpetual, and Trial. Fixed Perpetual licenses are also required to enable hardware
options.

Fixed Perpetual

Fixed Perpetual licenses are the traditional license type (Fixed) with the same
duration (Perpetual) that have been available for all features since the Keysight
X-Series introductions. Fixed Perpetual licenses are identified by the “F” in the
second character and “P” in the third character of the option designator:

Example: VO079B-1FP

A license key is instrument model and serial number dependent. You can only
install the license key on the specific instrument for which it was created.

Transportable Perpetual

Transportable Perpetual licenses are an optional license type offering deployment
duration which is not fixed to a specific instrument model and serial number.
Transportable Perpetual licenses are identified in the product structure by a “T” in
the second character and “P” in the third character of the option designator:

Example: V9079B-1TP

Transportable Perpetual licenses require a connection to the Keysight server only
for managing the check-in/out of the license. The Keysight licensing server also
provides for storage of unused licenses which have been transported off
instruments but are awaiting assignment to new instruments. The server will limit
the number of transports per 30 day period per application license to 10.

Unlike Fixed Perpetual licenses which are pre-installed at the factory with new
instrument purchases, Transportable Perpetual licenses require redemption and
installation of the license before the first use. This allows the user to determine on
which instrument to initially install the application license.

Keysight recommends that instruments be at the same instrument software
release to ensure the latest code is available on each instrument so that the user
experience is identical between instruments. This is particularly important when
transporting the license for a newly-released application which may only be
available in the latest software release.
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Time-Limited Licenses (Trial Licenses)

Trial licenses are available so that you may try applications before you buy the full
applications. These licenses are time limited for a 14 day period, and are restricted
to one trial for an individual application per instrument. The restriction is enforced
through the license redemption process of the Keysight Software Manager (KSM)
system.

Trial licenses are only available for measurement applications and not available for
enabling hardware capability.

Trial licenses are not installed in the factory and no entitlement certificates are
created for distribution with new instrument shipments. Trial licenses are not
available for order, but are available from the Keysight Web site after completing a
brief registration:

http://www.keysight.com/find/e6640a_trial
Trial Licenses are identified by the license designator “-TRL".
Example: V9079B-TRL

If a product has multiple tiers (levels of functionality), the ~TRL license enables all
tiers for the duration of the license. If you have a base tier and want a trial license
for a higher tier, you can install the -TRL license. When the duration expires the
entitlement is reverted back to the base tier.
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Licensing New Measurement Application Software - After Initial Purchase

Additional measurement application software can be ordered after your initial
purchase of the E6640A test set. Software upgrades are provided in a kit that
includes an option based Entitlement Certificate, a license agreement. The
licenses are downloaded from the license Web site onto a storage device so they
can be loaded into the instrument.

If you do not want to wait for your upgrade kit to arrive, licenses can be installed
using any available USB storage device. If you choose to do this, we recommend
that the latest version of the instrument software be installed. This ensures that
the measurement application being licensed and activated is installed and is the
most current version.

The latest revision of the software may be downloaded from:
http://www.keysight.com/find/e6640a

A license key is usually for one instrument model and serial number combination.
The license key will only install itself on that instrument.

No calibration is required after a test set application installation.

Installation procedure over USB

Step Action Notes
1 Redeem the Option = Follow the instructions on the Certificate After redeeming your Option Upgrade
Upgrade Entitlement Entitlement Certificate you will receive an
Certificate e-mail with an attached License File.
2 Save the license file = Save the .lic file to the root directory of a
USB storage device
3 Load the license file = Connect the USB storage device to one ofthe  Windows will detect the new hardware and
test set USB ports. may display the configuration menu.

The test set automatically loads the license
file. (This may take a few minutes) Upon
completion, the Keysight License Manager
displays a “Successful License Installation”
message.

Alternatively the license file can be manually installed over USB or LAN by placing the license

file in the following folder on the test set.

C:\Program Files\Keysight\licensing
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Step

4 Verify installation

Action

Cycle the power on the signal test set.

On the Virtual Front Panel press System,
Show, System.

Verify that the new application appears in the
list.

Test Set Operating System

Notes

4

The application will not be available for use

until after the power has been cycled

This displays the list of installed
applications.

If you require further assistance, please
contact the Keysight support team.

Online assistance:
http://www.keysight.com/find/assist

If you do not have access to the Internet,
contact your local Keysight Technologies
Sales and Service Office, or if in the United
States, call 1-800-829-4444.

Getting Started Guide
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Transporting a License Between Test Sets

Transportable licenses can be identified by the letters "TP" in their option
designator. For example, V9079B-2TP indicates the license is transportable and
perpetual. To transport this license from one test set to another, Keysight
recommends that both test sets be at the same instrument software release. This
ensures that the user experience is identical between instruments.

As a minimum, the instrument software release in the test set that will receive the
transportable license (the "target instrument") must at least be able to support the
desired application.

The E6640A test sets support several ways of transporting licenses. The procedure
below will focus on the most common procedure, where neither of the test sets
has access to an internet connection. For this procedure to work, a PC with an
internet connection is required

You will need the following:
USB flash drive
USB keyboard
USB mouse

We will refer to the test set from which the transportable license will be removed
as the "source instrument". We will refer to the test set which will receive the
transportable license as the "target instrument".

Procedure for Transporting a License, Neither Test Set Connected to the Internet

Step Action Notes
1 Connect the USB devices = Connect the USB flash drive, USB keyboard, It will be necessary to use one or more of
to the source instrument and USB mouse to the USB ports on the the rear panel ports to connect the USB
source instrument. devices.

2 Verify software versionin = On the Virtual Front Panel for each test set,  Ideally, the revisions will be the same. But

each test set

press System, Show, System and make at least, both versions should be able to

note of the Instrument S/W Revision on support the application whose license is
each. being transported.
3 Obtain the Host ID from = On the target instrument, press System, This information will be needed to issue the
the Target Instrument Show, System, and make note of the Host  license for the target instrument. The Host
ID. ID is the model number, followed by a

comma, followed by the serial number.

4 Start the License Man

ager = On the source instrument, press System,

on the Source Instrument More, Licensing... It may take a minute for

the Keysight License Manager screen to be
fully populated with all the installed licenses.
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Step

5 Transport the
Transportable License
from Source Instrument

Action

Test Set Operating System 4

Notes

a Onthe source instrument, locate the desired  Be sure you are selecting a transportable

license to be transported and highlight it. Its
option designator should include the letters
"TP".

.Right-click on the mouse and select
Delete.

Click Yes in the License Deletion
Confirmation dialog box.

After a few seconds, a Transport License
dialog box will appear. Click OK and save
the *.url files on the USB flash drive, with a
name such as "PhaseNoise_License.url"

license and not a fixed perpetual license.

Although you are "deleting" the
transportable license, the ultimate action
will be to transport it.

The information in this dialog box will be
used to issue a new license for the target
instrument.

6 GetNewLicensefromASM a

Transportation Web page

b

Insert USB flash drive into PC that is
connected to the internet

On the PC, locate the *.url file on the USB
flash drive that was saved in the previous
step and click on it.

After a few seconds, the ASM Transportation
Web page will appear. One field, the New
Host ID will be empty.

Enter the Host ID of the target instrument
(step 3 above) into the field marked New
Host ID.

The PC must have an internet connection
and an available USB port.

Most of the fields have been populated
from the information in the *.url file.

Be very careful when entering the New
Host ID. A mistake made in entering the
New Host ID will result in an invalid license

e Click Ssubmit. being issued. Be sure there is a comma
between the model number and serial
number. There should be no spaces in the
Host ID.

7 Save License FiletoUSB  a The ASM Transportation Web page will Either link can be used to either display or

Flash Drive

indicate that a license file is available and
display two links to the license file.
Right-click on the license file and select
Save Target As...

Save the license file to the root level of the
USB flash drive, keeping the ".lic" file
extension.

Close the Save dialog and exit the ASM
Transportation Web page.

save the license file.

The license file must be saved to the root
level of the USB flash drive for it to be
recognized by the target instrument.

Getting Started Guide
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Step Action
8 Install License File in a With the target instrument running, insert
Target Instrument the USB flash drive into one of the front

panel USB ports. After a few minutes, you
should see a message saying "Successful
License Installation”

b Cycle power on the target instrument.

¢ Once the test set has re-booted, the
application should be ready to use on the
target instrument.

Notes

The Keysight License Services running on
the target instrument looks for *.lic files
whenever it detects a USB device has been
inserted. If the contents of the *.lic file are
appropriate for the instrument, the license
will be installed automatically.

Newly-installed licenses are only
recognized by the instrument software on
power-up.
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Windows Configuration

The Windows settings have been optimized for the best measurement
performance. Any modifications to these settings may degrade test set
performance and measurement speed. In general, most Windows System settings
(typically set through the Windows Control Panel) should not be modified. Those
that can be safely modified are listed below.

To recover from problems caused by changing Windows systems settings, you
may have to reinstall the Windows system and test set application using the

Keysight Recovery process.

Settings that can be changed

You may change the following Windows settings or administrative tasks (available
from the Windows Control Panel) to select your personal preferences.

m Before changing any Windows System settings, exit the test set application.

ou may use this feature To do this...

?[ Windows Update Configure Microsoft Windows Automatic Updates.

e

'-!ﬁ ¥ Action Center Install and configure an Anti Virus program.

Set up new test set user accounts.

User Accounts Do not delete or modify the “KeysightOnly” or
g-l—‘ CAUTION

“AgilentOnly” user account.

KA Network and Sharing
Center

Add the test set to a network.

3_5!{".;] Devices and Printers  |nstall and configure a printer.

ks .
wiiy  Date and Time Set the time and date.
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ou may use this feature To do this...

Under Advanced System Settings, System Properties, Advanced, Performance:
By svstem choose either “Let Windows choose what'’s best for my computer” or “Adjust for
e ) best performance”. Leave all other settings unchanged.

Settings that must not be changed

Avoid changing any settings in this section. Changes to the following settings may
degrade test set performance, screen displays, and measurement speed.

Do NOT use this feature To do this...

Do not change Power Options.
\;; Power Options

:g.!_g System

Do not modify System Properties, Hard ware Tab settings.

Do not modify System Properties, Advanced Tab settings (except as
recommended under “Settings that can be changed” above).

Do not remove installed Fonts.

h Fonts

Do not change the following Display Settings:
! Display

Screen Saver settings (under “Personalization”)
Screen resolution, 1024 x 768 (under “Adjust Resolution”)
DPI setting (under “Set custom text size”)

Do not change any settings under “Region and Language” or the instrument
9 Region and Language keyboard and display may not operate properly

Do not delete or modify the “KeysightOnly” or “AgilentOnly” user account.
ﬂ'ﬁ User Accounts

In addition, DO NOT:
Add, delete, or modify hard-disk drive partitions.
Delete or modify Agilent/Keysight registry entries.

Change the contents of any directories containing the name “Agilent” or
“Keysight”.

Stop these services:
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— The MSSQL$CDF service or uninstall the “Microsoft SQL Server Desktop
Engine”

— The lIS server or tamper with any virtual directories (or their contents) that
came configured with the test set.

Uninstall these libraries, interfaces, or programs:

— The Agilent/Keysight I/0 Libraries

— The .NET Framework or any Hotfixes or Service Packs for the .NET
Framework

— The “Microsoft Visual J# .NET Redistributable Package 1.1"

— Programs that begin with “Agilent” or “Keysight”

— The Adobe Acrobat Reader

Modify

— The Agilent/Keysight I/0 Library “GPIB27”, “GPIB28” interfaces shown as
configured Instrument I/0 in the Agilent/Keysight Connection Expert or 1/0
Config.
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Configuring Printers

Printers are configured using the Microsoft Windows Control Panel. It is easily
accessed from the Windows Start menu or from under the front panel System key.
This setup process is most easily done using a USB mouse and an external
keyboard.

When setting up a new printer, you may need to load the printer driver (unless you
are using a network printer that your IT department has set up to include the
driver). The manufacturer of the printer supplies the driver software and process.
That may require that you attach an external USB disk drive. An alternative is to
connect the test set to the LAN and download the driver from the printer
manufacturer’s internet site.

Configuring LAN

100

Hostname

The Computer Name, or hostname, is pre-configured from the factory. It must be a
unique name so that it does not conflict with other equipment on your LAN. The
pre-configured Computer Name is A-E6640A-xxxxx, where xxxxx represents the
last b digits of the test set serial number.

To change the Computer Name consult the Microsoft Windows Help and Support
Center.

IP Address & Gateway

The test set is pre-configured to obtain an IP Address using DHCP. The IP Address
and Gateway can be changed. Consult the Microsoft Windows Help and Support
Center to configure the LAN.
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Windows Security
Microsoft recommends the following to ensure the test set Windows operating
system is protected:
Use an internet firewall.
Get the latest critical Windows updates.
Use up-to-date antivirus software.

To check the status or make changes in the security settings for your test set, click
Start, Control Panel, and then System and Security. The following window

appears:
@Ov“& v Control Panel » Systern and Security » - | +y | | Search Control Panel
Control Panel H :
Sl dll \P Action Center
jew g ve issues | (H) cettings
& Systemyand Sonirity Review your computer's status and resolve issues | gl Change User Account Cc.mtr?l settings
Treublesheot common computer problems | Restore your computer to an earlier time
Network and Internet .
Hardware and Sound ] ﬂ WIﬂdCI}WS Firewall ) )
Check firewall status | Allow a program through Windows Firewall
Programs ”
User Accounts and Family &.' S_yﬂem ) )
Safety View amount of RAM and processor speed | Check the Windows Experience Index

[ i . i
Arearnceand gl Allow remote access | See the name of this computer @JDEMCE Manager

Personalization _ {@} Windt}ws Update
Clock, Language, and Region @) Turn automatic updating on or off | Check forupdates | View installed updates

Ease of Access " "

\@ Power Options
Change battery settings | Require a password when the computer wakes
Change what the power buttons do | Change when the computer sleeps

g& Backup and Restore

Back up your computer | Restore files from backup

r_-_:@ BitLocker Drive Encryption

Protect your computer by encrypting data on your disk | Manage BitLocker

(2% Administrative Tools
"‘L‘;: Free up disk space | Defragment your hard drive | B Create and format hard disk partitions
'51' View event logs 'ﬁ' Schedule tasks

NOTE The window may look slightly different on your test set.
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Windows Firewall

Click Windows Firewall in the System and Security window to check the firewall
status of your test set. The test set is shipped with the Windows Firewall enabled.

[=E =]

@Uv|ﬂ v Control Panel » Systern and Security » Windows Firewall

Contraol Panel Home

Allow a program or feature
through Windows Firewall

|P:,!! Change notification settings

'{’:,!! Turn Windows Firewall on or
off

'.ﬁi' Restore defaults
'.‘fp:' Advanced settings

Troubleshoot my network

Seealso
Action Center
Network and Sharing Center

- | +y | | fegrch Control Pans! g o) [

@

Help protect your computer with Windows Firewall

Windows Firewall can help prevent hackers or malicious software from gaining access to your computer

through the Internet or a network,
How does a firewall help protect my computer?

What are network locations?

I '*@' Home or work (private) networks

I '-@' Public networks

Not Connected :'

Connected A

| Networks in public places such as airports or coffee shops

Windows Firewall state:

Incoming connections:

Active public networks:

Maotification state:

Cn

Block all connections to programs that are not on the
list of allowed programs

T Metwork 2

Do not notify me when Windows Firewall blocks a
new program

The window may look slightly different on your test set.

Windows Firewall exceptions for programs and ports have been added to allow
proper operation of the test set over a network. Modifying these settings may
prevent the test set from operating properly.
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Automatic updates

The default test set setting is to automatically check for critical Windows Updates
and notify you, if the test set has internet access.

You can change the configuration of the Microsoft Automatic Updates. Under
Windows Update in the System and Security window, click Turn automatic
updating on or off to change settings. If you choose not to have automatic

updates, you can manually update windows by clicking Check for updates on the
System and Security window.

=8 e |

@uv| £ e Systern and Security » W¥indows Update » Change settings - |&, | | Search Controf Panel D |

Choose how Windows can install updates

When your computer is onling, Windows can automatically check for important updates and install them

using these settings, When new updates are available, you can alse install them before shutting down the
computer,

How does automatic updating help me?

Important updates

Check for updates but let me choose whether to download and install them b

Install new updates: | Every day at |3:00 AM
Recornmended updates

[] Give me recemmended updates the same way | receive important updates
Who can install updates

[#] Allow all users to install updates on this computer

Mote: Windows Update might update itself automatically first when checking for other updates, Read our
privacy statement online.

[ OK H Cancel ‘

Be aware that downloading and installing Windows Updates can be network and
CPU usage intensive (impacting the test set performance), and some Windows
Updates automatically reboot the test set. It is recommended that Windows
Updates be performed when the test set is not in normal use.
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E=N EOR ==
@Uvrﬁ » Control Panel » Systern and Security » Action Center - | +,-| | Eearch Control Panel gel [
@ -
Control Panel Home ¢ 0
Review recent messages and resolve problems
Change Action Center settings Action Center has detected one or more issues for you to review,
Change User Account Control
Security &
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Virus protection

Under Action Center in the System and Security window, click Review your
computer’s status and resolve issues to check the status of virus protection on
your test set. There is no antivirus software included with your test set. Antivirus
application software has been tested to be compatible with the test set. See the
section on “3rd party software verified by Keysight" on page 87 for anti-virus
software that has been tested by Keysight.

performance.

Having antivirus software installed may have a slight impact on the test set

settings
Wiew archived messages

View performance information

See also
Backup and Restore
Windows Update

Windows Program
Compatibility Troubleshooter

Spyware and unwanted software protection (Important)
¥4 Windows Defender is turned off.

Turn off messages about spyware and related protection Get a different antispyware program

Turn on now

online

m

Virus protection (Important)

Find a program online

Windows did not find antivirus software on this computer,

Turn off messages about virus protection

Windows Update

Windows Update is set to check with you before downloading and installing
updates.

Turn off messages about Windows Update

Maintenance

Set up backup
Your files are not being backed up.

Turn off messages about Windows Backup

Spyware protection

Change settings...

%/ 5et up backup

The Review your computer’s status and resolve issues window described above
also shows the status of spyware protection. There is no anti-spyware software
installed on the test set. This should not be a problem if you do not use the test set
for a lot of internet browsing. Having spyware in the test set could have an impact
on the test set performance.
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System Maintenance

Backup

It is recommended that you have a regular backup strategy. Your IT department
may already have a backup strategy in place which is suitable for the test set and
its data. Using the Keysight Recovery system in conjunction with a regular backup
strategy should allow full recovery of the test set data.

The Windows operating system has a Backup utility that you can use to archive
files and folders in case of a hard disk drive failure. See the Microsoft Windows
Help and Support Center for more information on this utility. You can also use third
party backup utilities. However, you must ensure that this third party software is
compatible with the test set's system software. See “Customer Installation of
Software" on page 87 for more information.

When performing backups, we recommend that you backup the data to an
external storage device connected to the network or one of the test set's USB
connectors. Also, you should perform backups at times when the test set is not
being used for normal operations as it may impact the test set's overall
performance.

System restore

Windows contains the capability to restore the system to a previous point in time.
System Restore is enabled with default settings as provided by Microsoft.
However, System Restore is not 100% successful. Therefore, it is not the
recommended method to backup the test set. System Restore has not been tested
to verify successful restoring.

Disk defragmenting

Over time the hard disk on the test set becomes fragmented. Windows has a Disk
Defragmenter utility that you can use to defragment the hard disk. See the
Microsoft Windows Help and Support Center for more information on this utility.

Running Disk Defragmenter should be performed when the measurement
application is not running. Measurement throughput is significantly impacted
while disk defragmentation is in process.
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USB Connections

106

The controller front panel provides two USB 3.0 ports and four USB 2.0 ports to
which you can connect USB mass storage devices and accessories such as
printers and keyboards. The test set USB Host support includes the standard
Microsoft Windows USB class drivers for human interface, mass storage, printing,
scanning, and imaging devices. A complete up-to-date list of the Windows USB
class driver support is available on the Microsoft website.

http://www.microsoft. com/vvhdc/system/bus/usb/USBFAQ intro.mspx
DRI\.I’E POWER lJSFR
ecee
TRIG

f{; '

/

LAN Ports

USB 3.0 |55}

o0 Bl @ | USB 3.0Ports

USB 2.0 Ports

The test set USB device driver included in the test set software supports the test
and measurement industry standard USBTMC-USB488 device class.

In addition, the Agilent/Keysight IO Libraries CD that was included with your test
set contains USB Host drivers that allow control of other test sets connected to
the USB bus.

Keysight Technologies does not support or warrant correct test set operation if
additional USB drivers from third parties are installed in the test set. It is possible
that additional drivers could break the normal USB operation. If USB operation is
broken, recovery would require reinstalling the test set application using the hard
drive recovery process.
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Hard Drive Partitioning and Use

Getting Started Guide

The drive is partitioned into 3 sections: C:, D: and E:

The C: partition contains the Windows operating system and software installed
by Keysight. This is an Open System which means you can install additional
software, and these should be installed on the C: drive. However, only a limited
set of software applications are tested for use with the Keysight measurement
software. The installation and/or use of other software is not warranted, and
could interfere with the operation of the measurement software. If test set
repair is ever needed, the Keysight version of the C: drive is the only part of the
test set software that is restored by the Keysight Recovery process. You must
reload any other software that you have added in the test set.

The D: partition is reserved for data storage. The User Accounts that are
configured by Keysight have their My Documents folder mapped to the D: drive.
This is for the convenience of backing-up the measurement data. You should
always back-up the data on the D: drive to an external device. This allows you
to restore the data if you ever need to replace the hard drive.

The E: partition is reserved for Keysight’s use. The primary use of the E: drive is
for housing the Calibration and Alignment data. Do not change or overwrite the
files on this drive. This could cause your test set to not meet specifications, or
even to stop functioning correctly. Do not use this drive for data storage. It is
also recommended that you back up the contents of this drive by using the
factory calibration data backup utility.
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Hard Drive Recovery Process

108

The Keysight Recovery System can be used to repair errors on the test set's C:
drive partition, or to restore the original factory configuration of the system
software. The Keysight Recovery System is stored in a separate hidden hard disk
drive partition.

Repairing errors on the hard disk drive may result in loss of data or files. If you
need more information about the Windows “chkdsk” error repair process, see the
chkdsk documentation in the Microsoft Windows Help and Support Center.

Restoring the original factory system software does not restore any of the
following items:

Windows system configurations that were made after the test set was shipped
from the factory. For example, Windows and Service Pack updates, user
accounts, and Windows configuration settings. After an Keysight Recovery,
these configurations need to be redone.

Additional software that was installed after the test set was shipped from the
factory. After an Keysight Recovery, that software needs to be re-installed.

Any data or programs saved on the D: or E: drives.

Any upgrades that were made to the Keysight measurement application
software.

Restoring the original factory system software will not synchronize the code in the
Field Programmable Gate Arrays (FPGAs) on the various hardware assemblies. As
a result, you may see an error dialog box appear during the final boot-up at the
end of the recovery process. This typically occurs when there are significant
differences between the software version installed prior to performing the recovery
and the version restored by the recovery. In these situations, upgrade the software
to the latest version.

It is recommended that you use a regular back up strategy. Your IT department
may already have a back up strategy in place which is suitable for the test set
and its data. See “System Maintenance" on page 105. Using the Keysight
Recovery System in conjunction with a regular back up strategy should allow
you to fully recover the test set software and data.

It is recommended that routine backups of the test set information be performed
to keep current archives of the test set information. This allows a full recovery of
the test set information after the test set recovery system operations are
performed. See “Backup" on page 105 for more details.
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Table 3-1 Using the test set recovery system

1 Make sure the test set is turned off.

2 Turn on the test set. After the Keysight Technologies screen is
Press the down arrow key to move the highlight ~ displayed,
to Keysight Recovery System, then press Enter.

KEYSIGHT

TECHNOLOGIES

This screen is displayed for five seconds.

wir

choose an operating syst

3 When the Keysight Recovery System has
booted, follow the on-screen instructions to
recover the image of the C: drive.

Press 2, then press Enter to select the

recovery.
It may take up to 25 minutes for this process to

Press 1, then press Enter to continue. complete

Press 1, then Enter to confirm.

After exiting the Keysight Recovery System, the test set reboots. If the original factory test set system
has been restored, the test set re-executes the following process:“Turning on the test set the
first time" on page 17

Additional recovery steps may be required to fully recover the system to a more
current working state. This could involve restoring your own backups of the test set
configuration, including re-installing applications, data, and performing system
customizations.
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Updating the software

The purpose of this update is to ensure that the E6640A’s software, its
measurement mode applications, and the FPGA content of its PC boards are all
current and up to date.

An update to the instrument software revision does not require
a new license key for the measurement applications, so long as
the applications were licensed prior to the update.

This procedure will only update the instrument software that
currently resides on the C: drive of the instrument. It will not
update the version that exists on the recovery partition.
Because of this, if the recovery process is performed, the
instrument will revert back to the instrument software revision
that was originally shipped from the factory.

Determining the current software revision

To determine what revision of instrument software is currently installed, press
System, Show, System using the instrument’s virtual front panel. You can access
the virtual front panel using a mouse and right-clicking in the application window,
and selecting Utility, Virtual Front Panel. Once in the show system screen, look for
the "Instrument S/W Revision" entry (for example: "A.13.85"). If the installed
revision is the same as the latest revision on the web, there is no need to update
the instrument software.

Requirements

The following requirements must be met to use this procedure:
The E6640A must be functioning properly before the update is attempted.
You must have a USB keyboard and mouse.
You must be able to log in to the instrument as the administrator.

You must be able to transfer a large file (~1 GByte) to the E6640A being
updated.
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File Download

1. Go to http://www.keysight.com/find/e6640a and go to the Technical Support
section; select the Driver, Firmware & Software tab.

2. Download the executable file by clicking on the file link. Save the file to a
location of your choice. If you do not have the ability to download files directly
to the C: drive of the E6640A being updated, store the file on a large capacity
USB storage device for transfer to the instrument. (The file size is ~1 GByte.)

User account and log-in

The default user account is Instrument, which does not have the required
permissions to install the instrument software updates. For the process outlined
below, the user must be logged in as Administrator.

The automated instrument software upgrade process has an install wizard which
removes the old software version and installs new software version without manual
steps. The removal of the old software version and the installation of the new
software version completes in approximately 15 minutes.

1. Connect a USB keyboard and mouse to the E6640A.

2. If the EB640A is not already running, power it up and allow it to boot up
completely.

3. Close the E6640A measurement application if it is running. Right-click in the
application window, and select elect Utility > File from the right-click menu;
select the Exit softkey and click OK in the confirmation window.

4. Log out as the default user (Instrument). Click the Start icon at the lower left
corner of the screen, and select Log Off.

5. Select the Administrator icon on the Windows desktop, to log in as follows:
User Name: administrator
Password: Keysight4u!

6. If a “Found New Hardware” wizard window pops up, select “No, not at this
time” to bypass the activity.
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Instrument software installation

If you downloaded the instrument software update file to the instrument via LAN,
access that file from the location that it was stored and proceed to step 1.

If you downloaded the instrument software update file to a USB storage device,
plug that into one of the USB ports on the front of the instrument. Access the file
for the removable drive, then proceed to step 1.

Table 3-2 Preparing the installation

1 Double click on the installer file, and click Yes
in the confirmation window that appears.

The file name is in the format:
XSA Installer A.XX.XX.exe

2 A window appears showing the extraction of
the software installer. Click Install in the
confirmation window to begin the installation
process. When the extraction process is
complete, a software updater display appears,
showing progress of the software removal and

The update process causes various messages
and windows to appear and disappear on the
screen, but the process doesn’t require further
interaction. Examples of what will be displayed
are shown below, as a guide to what the process
looks like while it is running.

installation.

Extraction window:

B Keysight X-Series Software Update

Extracting files to temporary Folder

Extracting ¥SA_Installer_E.14.60_R0O0O01_xf4.exe

Installation progress
——

M; KEYSIGH
TECHNOLOGIES

Install
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Table 3-2 Preparing the installation

Software updater window, showing uninstallation progress:

Welcome to Keysight XSA Software Updater

Uninstall XSA Version A.14.36: Progress ... ... Uninstall In

Install XSA Version E.14.60_R0001:

KEYSIGHT

TECHNOLOGIES

While the old instrument software is being uninstalled, the text “Uninstall in Progress” text rolls
across the screen, to be replaced finally by “Completed Successfully”. No interaction is required at
this point.

Software updater window, showing installation progress:

Welcome to Keysight XSA Software Updater

Uninstall XSA Version A.14.36: Completed Successfully

Install XSA Version E.14.60_R0001: rogress ... ... Installation In P

KEYSIGHT

TECHNOLOGIES

While the new instrument software is being installed, the text “Installation in Progress” text rolls
across the screen, to be replaced finally by “Completed Successfully”. No interaction is required at
this point. Please be patient: the total installation process can take 30 to 40 minutes.
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Table 3-2 Preparing the installation

FPGA update warning window (may be displayed, if any FPGA updating occurs):

Updating Baseband Generator (136.1) FPGA from version 0.0.2.1 to 0.0.2.3

Do not turn off power or interrupt this process!
A2 X ] s B P Bt A R

BREYHED, EHIOLAZHELEDLGUT TS,
HAE DAL HEE = HYHS SH AlIFIX DA R!
Ne pas interrompre ni couper lI'alimentation électrique!
Nicht ausschalten oder abbrechen!

He BbiknioyaTh 1 HE npepbiBaTh Npouecc!

FPGA code updates may require a significant period of time. Interrupting the FPGA update process
may resultin corrupt FPGA code which would require returning this instrument to Keysight for service.

During FPGA programming, DO NOT power off the E6640A for ANY reason!
CAUTION Interrupting the FPGA update process can place the instrument in an unusable
state, requiring it to be returned to Keysight for repair.

3 When the software updater window shows Reboot the E6640A by clicking Finish in the
“The software upgrade was successful”, you  window. Windows will display a “System
will be prompted to shut down and restart the  Shutdown” warning window; this is normal.
system.

Software updater window, showing completion of the process:

Welcome to Keysight XSA Software Updater

Uninstall XSA Version A.14.36: Completed Successfully

Install XSA Version E.14.60_R0001: Completed Successfully

The software upgrade was successful!‘

A mainframe/chassis power shut down and restart is required to complete the process.
Please click the Finish button to shut down the system and you must power-on the

chassis manually. K EYS I G H T

e TECHNOLOGIES
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Table 3-2 Preparing the install

Test Set Operating System 4

ation

4 Click the “Finish” button. This results in a Windo

! You are about to be logged off

minute.

Windows will shut down in less than a

ws shutdown.

=

Close

After you power the E6640A back on, it will
boot up in the default “Instrument” account,
perform alignments, and finally display the

If the instrument does not reboot, remove the
USB storage device and cycle power. The boot
order for the instrument may have been changed

in the instrument BIOS previously, and the
instrument may be instructed to boot from USB
first, and the internal drive second. If this is the
case, failure to remove the USB device will result
in an error, as the instrument attempts to boot
from it.

measurement screen.

Check for any errors, and verify that the new
software version is installed.

In the right-click menu, Press System. In the
System menu, press Show, System. Look for
the line “Instrument S/W Revision”.

Instrument S/W Revision:

BE Keysight - TRXL - 1Q Analyzer (Basic) - Complex Spectrum
RFIOL [ 509 AC | [

{Prototype - Limited Sale Allowed)
| SENSEINT| RFOFF | /MALIGNOFF |
Center Freq: 1.000000000 GHz
Trig: Free Run Avg
Range: 0 dBm

Center Freq 1.000000000 GHz

Keysight Technologies
Keysight EXM

Product Number

Serial Number
Instrument S/W Revision
Revision Date

Keysight EXM Wireless Test Set
E66404

US53300099

E.14.60_R0001

8/18/2014 2:34:03 PM

Computer System Windows 7, Service Pack 1

Cornputer Name A-E6640-00098

IP Address 141.121.90.32

IPv6 Address 2001:0:9d38:6ab8: 3421 1¢6a 7286:a5df
Lirk-Local IPvE Address  feB0:342f 1¢6a:7286:a5df%3

Host 1D PCSERNO,GAS5287274

mDNS Enabled Yes

mDNS Host Name A-EE6640-00099

It is possible a newer version of the instrument software is available on the web at
http://www.keysight.com/find/e6640a

Additional recovery steps may be required to fully recover the system to a more
current working state. This could involve restoring your own backups of the
instrument configuration, including re-installing applications, data, and performing
system customizations.
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Configuring recovery prompt timing

You can configure the time at which the test set power-up process waits for the
selection of the recovery process by performing the following steps:

1 From the Windows Start menu, This opens the System window.
right-click Computer and click
Properties.

2 Click Advanced System Settings in the This opens the System Properties window.
left pane.

3 In the Startup and Recovery section, This opens the Startup and Recovery window.
click Settings.

4 Under the System Startup section:

= you can either clear the Time to
display a list of operating
systems check box,
or,

= select the Time to display
recovery option
when needed check box and
change the seconds to
delay for it

_ You must be logged in as an administrator to change these settings. See “User
Accounts" on page 88 for more information.
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Using Microsoft Windows Operating System

m The capabilities described in this section are Microsoft Windows features. The
following information provides some guidelines for using the capabilities with
the test set. You need to refer to the Windows help documentation for more
information. Your version of Windows may not match these instructions exactly.

You need an external keyboard and mouse to fully use these features.

“Navigating Windows Without a Mouse" on page 118
“Remote Desktop: Using the Test Set Remotely" on page 119
“Programmatic Control of the Test Set" on page 133
“Capturing/Printing Displays and Windows" on page 134

“Windows Shortcuts and Miscellaneous Tasks" on page 135

KEYSIGHT

TECHNOLOGIES

117



5
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Navigating Windows Without a Mouse

118

Key Presses Actions

Esc Exits/closes a Windows dialog box (does not exit an Application window)

Enter Does the current "default action". If a menu item or a button is currently
highlighted, then the Enter key activates that menu item or button.

Alt Moves focus/control to the pull down menus bar in the active Window

Right Arrow In pull-down menu: opens the next menu to the right, or opens a submenu

In a dialog box: selects an option button

Left Arrow In pull-down menu: opens the next menu to the left, or opens a submenu

In dialog box: selects an option button

Up Arrow In pull-down menu: Moves to next selection up in the menu

In dialog box: selects an option button

Down Arrow In pull-down menu: Moves to next selection down in the menu

In dialog box: selects an option button

Tab In dialog box: moves to the next/previous field

Del Deletes the currently selected item

Alt + Tab Switches between the next/previous Application

Alt + Enter Shows the Properties of the currently selected item

Alt + Esc Cycles through items in the order that they had been opened
Backspace In My Computer or Windows Explorer: move up one level

In Internet Explorer: works like the BACK arrow key

Ctrl + Left arrow Moves to the left one word at a time

Ctrl + Right arrow Moves to the right one word at a time

Ctrl + Tab In dialog box: moves to the next/previous Tab location

Alt + Space Opens the window control menu for the currently active window, allowing you
to minimize, maximize, move and restore (size) the window

Ctrl + Esc Opens the Windows Start Menu

Ctrl + Alt + Delete Opens the Windows Task Manager
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Remote Desktop: Using the Test Set Remotely

Windows Remote Desktop is recommended for remote control of the test set.
The Remote Desktop functionality is a Microsoft Windows capability. The

following discussion provides some guidelines for using this capability with
the test set. You need to refer to the Windows help documentation for more
information. As Windows evolves, these instructions may no longer be exact.

Overview of Remote Desktop operation

Using the Remote Desktop functionality of the test set allows you to control and
interact with the test set from a remote computer, as though you were sitting in
front of the test set.

When you have configured the test set for remote connectivity, and configured a
separate computer to act as a Remote Desktop Host, you can send commands to
the test set from the remote computer, and you can see the test set display on the
screen of the remote computer.

This section provides full details of how to set up the test set for remote
connectivity, and also how to set up a computer running any 32-bit version of
Microsoft Windows as a Remote Desktop Host.

Setting up Remote Desktop operation

Setting up the test set

Before the test set can be controlled through a Remote Desktop Connection, it
must be set up to allow connection from a remote computer.

Table 3-3 Setting up a remote desktop connection

Step Notes

1 To perform this operation successfully, you  The default Administrator password is:
must have Administrator level access to the Keysight4u!
test set.

2 On the test set, open the Windows Control
Panel.

Using the Virtual Front Panel within the test set

application, press System, Control Panel,

or,

From the Windows Desktop, click Start,
Control Panel.

3 Within the Control Panel, select System,
System and Security.
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Table 3-3 Setting up a remote desktop connection

4 Click Remote Settings. A System Properties window appears, with the
Remote tab displayed.

5 Check the box labeled Allow Remote
Assistance connections to this computer,
if it is not already checked.

6 To add users, click Select Users, Add.
= Follow the on screen instructions.

Figure 3-1 Basic setup for remote desktop operation

REMOTE
DESKTOP
CONTROLLER

E6640A TEST SET
< Display Content | : — gt

i o o o e .\\- |
=

—_— =
[ LAMN Connection (Ethernet)

Setting up the remote computer

Keyboard and Mouse Input

The procedure depends on whether the Remote Computer to be set up is running
Windows XP, Windows 7, or another version of Microsoft Windows.

Remote computer running Windows XP or Windows 7 Windows XP and Windows
7 include the Remote Desktop Connectivity Client software, so no additional setup
is required.

Remote computer running another version of Windows You can use any 32-bit
version of Windows (Windows 95, 98, ME, NT4, or 2000) to install and run the
Client software for Remote Desktop Connectivity. However, you need to have
available a Windows XP or Windows 7 installation CD-ROM, because that contains
the Client software.

] The following instructions relate to software provided by Microsoft

Corporation. Keysight offers no warranty regarding the operation of such
software. The procedure described here may be changed by Microsoft at some
future time.
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Table 3-4 Installing the Client software

5

1 When the Welcome Screen appears, click
Perform additional tasks

2 From the What do you want to do? screen, The Remote Desktop Connection InstallShield
click Set up Remote Desktop Wizard appears.
Connection.
3 Click Next. Follow the on screen instructions provided by
the Wizard.
4 To access the installed software, click

Start > All Programs > Accessories >
Communications > Remote Desktop
Connection.

ate the computer name of the test set

To connect a remote computer to the test set, you need to know its Computer
Name. The Computer Name can be displayed as follows:

Table 3-5 Locating the name from the Keysight application

= On the test set front panel, press System, A page listing various parameters appears.The

Show, System. test set’s computer name is shown in the list next

to the title Computer Name.

Table 3-6 Locating the name from the Windows desktop (with a
mouse)

1 Click Start, Control Panel. In the Control Panel window, select System and
Security, System.
2 The computer name is displayed in the The Computer Name is listed as Full computer
System window, under the heading name.
“Computer name, domain, and workgroup
settings”.
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Table 3-7 Locating the name from the Windows desktop (without a
mouse)

1 Press Ctrl+Esc to display the Windows Start
menu.

2 Use the Up Arrow or Down Arrow keys to
select the Control Panel item.

3 Press Enter to open the Control Panel dialog.

4 Use the Tab key to highlight System and The System and Security window is displayed.
Security, then press Enter.

5 Use the Tab key to highlight System, then The System window is displayed.
press Enter.

6 The computer name is displayed in the The Computer Name is listed as Full computer
System window, under the heading name.
Computer name, domain, and workgroup
settings.

7 To close the Control Panel dialog:
= Press Alt to open the drop-down File
menu
= Press the Down Arrow until the Close
menu item is selected
= Press Enter to close the Control Panel
dialog.

Running a Remote Desktop session

Initializing a Remote Desktop session

To initialize a Remote Desktop Session, you need to know the Computer Name
of the test set. This information can be shown on the test set display by
following the procedure in the section “How to locate the computer
name of the test set" on page 121.

After setting up both the test set and the remote computer for Remote Desktop
Connectivity, as described in “Setting up Remote Desktop operation" on
page 119, you are ready to start a Remote Desktop session.
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Table 3-8 Starting a session

5

1 Click Start > All Programs > Accessories > A Remote Desktop Connection dialog appears:
Remote Desktop Connection.
T8, Remate Desktap Connection =Er=

| Remaote Desktop
+>¢) Connection

Computer [Example: computer. fabrikam, com -
Username:  Mone specified

The computer name fisld is blank. Enter a full emote computer
name.

2 Enter the computer name or IP address of the
test set.
3 Click Connect. A login dialog box appears.

4 Enter the login account name and password.  The default account name is Instrument and the
default password is measure4u, but these
parameters may be changed by instrument users.

: Only the current User or an Administrator can remotely log into the test set.
To see who the current user of the test set is, press Ctrl+Esc on the test set

until you can view the current user name on the Start menu. If no one is

currently logged into the test set, any valid instrument user can remotely log
in.

The test set display appears on the screen of the remote computer. Because the
test set front-panel keys are not available when using the test set remotely, three
alternative methods are available to perform the functions of the front-panel keys,
as detailed in the following sections:

“Accessing menus for Remote Desktop operation" on page 127
“Keycode commands for Remote Desktop operation" on page 128

“The Virtual Front Panel" on page 132
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Setting Remote Desktop options

Table 3-9 Setting options

Step

1 On the Remote Desktop Connection
window, click Options. The window
expands vertically to show several
configuration tabs.

Notes

i Bl
& Remote Desktop Connection El_ﬂ

| Remote Desktop
»¢ Connection

General | Display I Local Resources I Programs I Experience I Advanced

Logon settings
E,'.v“l Enter the name of the remote computer.
—

Computer: A-EGE50A-D0109) -
Username:  A-E6650A-00109"Administratar

You will be asked for credentials when you connect.

[] Mllow me to save credentials

Connection settings

Save the cument connection settings to an ROP file or open a
* saved connection.

[ Save ] [ Save As... ] [ Cpen... ]

'r/ ‘ Options ’ [ Connect ][ Help ]

-

]

The Options dialog has several tabs. Generally, the default
settings are correct.

2 Under the General tab, ensure that
the Computer name, User name and
Domain name are set correctly.

You may choose to enter the password and save it for
future sessions, by checking the Save my password box.
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Table 3-9 Setting options

Step

3 Click the Display tab.

= Under Remote desktop size,
you may select the size of the
window in which the test set
display appears. Do not select any
size smaller than 1024 x 768
pixels. Selecting a remote desktop
size smaller than 1024 x 768
results in the test set display not
being fully visible. In such
circumstances, scroll bars do not
appear, so portions of the display
are not accessible.

= Under Colors, you may select any
setting that uses 15 bits or more.
Selecting a color setting that uses
less than 15 bits results in
dithering and incorrect color
rendition of the remote desktop
window.

Using Microsoft Windows Operating System 5

‘Notes

&, Remote Desktop Connection

| Remote Desktop
“>< Connection

| General | Display | Local Resources | Programs | Experience | Advanced

Display configuration

way to the right to use the full screen.

Full Screen

Colors

[Highest Quality (32bi) -

Display the connection bar when | use the full screen

Choose the size of your remote desktop. Drag the slider all the

[ Use all my monitors for the remote session

l Choose the color depth of the remote session.

(& Options [ Connect ][ Help ]

4 Click the Local Resources tab.
= Click the More button to see a

selection of local resources;
selecting the Drives checkbox
enables you to transfer data
between the remote desktop and
the local PC.
To transfer data, click Start on the
task bar of the remote computer,
then click My Computer.
Explorer opens on the remote
computer and displays the drives
of both the remote computer and
the local computer. You can now
copy and paste between the two
disk drives.

p
& Remote Desktop Connection

(= )

| Remote Desktop
<>< Connection

General | Display | Local Resources | Programs I Experience | Advanced

I —
cal devices and resources ™"

use in your remote session.

5 Smart cards
[ Ports

g Choose the devices and resources on this computer that you want to

= [V Drives
Local Disk (C:)

> of
#2|  your Rmote session.

i~ Options Connect ] [ Help

Getting Started Guide
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Table 3-9 Setting options
Step ‘Notes
5 Click the Experience tab. To Optimize the performance of the Remote Desktop

session, choose the appropriate connection format from
the drop-down list.

p
B Remote Desktop Connection = | —

| Remote Desktop
»¢) Connection

| General I Displayl Local Resources I Progrclm5| Experience | Advanced

Performance

Choose your connection speed to optimize perfformance.

(AR 0 Mogs or higher a3

AMlow the following:

Desktop background

Fort smoothing

Desktop composition

Show window contents while dragging
Menu and window animation

Visual styles

Persistent bitmap caching

Reconnect if the connection is dropped

\A Options Connect ] [ Help
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Accessing menus for Remote Desktop operation

Using the mouse, right-click the application display window to access the
following remote desktop menus:

Setup b = Frequency
. Marker ). = Marker || Span
. Control b = Trigger . Peak Search | | Amplitude
Maode » Sweep-Control || Marker To . Input-Output
t = (List of Modes) 1| 11
Meas 3 Restart Marker Function View-Display
I Mode Preset .. (Listof Single . Trace-Detector
I 1 Measurements) I
User Preset Continuous Auto Couple
Utility b = System . BW
. Window b= Zoom File .Source
Return Split Screen . Quick Save . Mode Setup
. Local Next Save . Meas Setup
Help . Full Screen Recall
Exit Page Setup
Print
Virtual Front

Fanel

The function of each selection in the menu is generally identical to that of the
corresponding Virtual Front Panel key. The following lists additional functionality:

Exit — Selecting this item closes the Application software.
Utility > Page Setup - Selecting this item opens a printer setup dialog.

Utility > Virtual Front Panel — Selecting this item opens the Virtual Front Panel
window, as described in the Section “The Virtual Front Panel" on page 132.

The menus are also available when using the test set directly, provided that a
mouse or other pointing device is attached to it.
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Keycode commands for Remote Desktop operation

When using the test set in remote desktop mode, the following combinations of
remote keyboard keys can be used to perform the operation of the virtual
front-panel keys.

Agilent X-Series Wireless Test Set
Remote Desktop Keycodes
ANALYZER SETUP MARKER UTILITY
Ctri+Shift+F Ctri+Shift+O Ctri+Shift+C  Ctri+Alt+K  Ctrl+Shift+Y Ctri+M

v R ) () (o () G

L

Ctri+ShiftsS Ctrl#Shift+V  Ctri+Alt+B  Ctri+Alt+P Ctri+Q Ctri+U
C‘:"*S“*“Fz b (] (o) [y (SR ] [ )
: ' Ctrl+ShiftsA  Cirl+Alt+T  CtrivAlt+U  Ctrl+Alt+N Ct+S Ctri+F
Ctri+Shift+F3 (AMPTD Trace! [aoun:- ] [Illarlmr ] [ Save ] [ﬁle ]

Ctrl+Shift+M Ctri+ShifttE  Ctri+Shift+T  Ctri+Alt+F R Ctri+P

oounr \CEREel Gl laagl (=< N8 |

MEASUREMENT
Ctri+AltsM  Ctrl+Alt+E  Ctrl+Shift+W  Ctrl+Alt+R  Ctri+Alt+S  Ctri+Alt+C

Ctri+Shift+F5 ‘Mera Meas Sweap! Restart Single Cont J
H—'a-mp Control '—' I—' |—‘

L

L

Esc Delete  Backspace
Ctrl+Shift+F6 Tk Dol Bk Sp
:) e e ()
Ctri+Shift+F7
Shift+Tab Tab Space Bar Ctrl Alt
al (] (=1 Men
Ctri+Shift+R Ctrl+Shift¢L  Ctri#Shift+Z Ctrl+Shift+N F1 Ctrl+Shift+B

= & &)

Table 3-10 Keycode commands

To initiate the following virtual key: Press these keys on the remote computer
keyboard:

AMPTD Y Scale Ctrl+Shift+A

Auto Couple Ctrl+Shift+C

Bk Sp Backspace

BW Ctrl+Alt+B

Cancel (Esc) Esc
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Table 3-10 Keycode commands

To initiate the following virtual key:

Press these keys on the remote computer
keyboard:

Cont

Ctrl+Alt+C

Ctrl

Ctrl

Decrease Audio Volume

the Volume Control slider

Del Delete

Down Arrow Down Arrow
Enter Enter (Return)
File Ctrl+F

FREQ Channel Ctrl+Shift+F
Full Screen Ctrl+Shift+B
Help F1

Increase Audio Volume

the Volume Control slider

Input/Output Ctrl+Shift+O
Left Arrow Left Arrow
Marker Ctrl+Alt+K
Marker -> Ctrl+Alt+N
Marker Function Ctrl+Alt+F
Meas Ctrl+Alt+M
Meas Setup Ctri+Alt+E
Menu (ALt) Alt

Mode Ctrl+Shift+M
Mode Preset Ctrl+M

Mode Setup Ctrl+Shift+E
Mute the Mute checkbox under the Volume Control
Next Window Ctrl+Shift+N
Peak Search Ctrl+Alt+P
Print Ctrl+P

Quick Save Ctrl+Q
Recall Ctrl+R
Restart Ctrl+Alt+R
Return Ctrl+Shift+R

Getting Started Guide
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Table 3-10 Keycode commands
To initiate the following virtual key: Press these keys on the remote computer
keyboard:
Right Arrow Right Arrow
Save Ctrl+S
Select Space Bar
Single Ctrl+Alt+S
Softkey 1 Ctrl+Shift+F1
Softkey 2 Ctrl+Shift+F2
Softkey 3 Ctrl+Shift+F3
Softkey 4 Ctrl+Shift+F4
Softkey 5 Ctrl+Shift+F5
Softkey 6 Ctrl+Shift+F6
Softkey 7 Ctrl+Shift+F7
Source Ctrl+Alt+U
SPAN X Scale Ctrl+Shift+S
Split Screen Ctrl+Shift+L
Sweep/Control Ctrl+Shift+w
System Ctrl+Shift+Y
Tab Tab
Trace/Detector Ctri+Alt+T
Trigger Ctrl+Shift+T
Up Arrow Up Arrow
User Preset Ctrl+U

View/Display Ctrl+Shift+V
Zoom Ctrl+Shift+z
1 12
2 e
3 32
4 22
5 52
6 62
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Table 3-10 Keycode commands

To initiate the following virtual key: Press these keys on the remote computer
keyboard:

8

9 92

- Use the — key to enter a negative value, as
appropriate®

. (Decimal Point) . (Period)?

0 (Zero) 0 (Zero)?

a. For remote keyboards that feature a numeric keypad, use either the
appropriate numeric keypad key or the main keypad key.

The effect of pressing Ctrl+Alt+Delete on the keyboard of the remote

m computer always applies to the remote computer, and not to the test set.
Generally, the effect of pressing this key combination is to display the
Windows Task Manager. Therefore, pressing this key combination on the
remote computer does not allow you to reboot the test set.

Ending a Remote Desktop session

There are two ways to disconnect the remote computer from the test set to end

the session:

1 Click the X, then click OK. For full-screen, the X appears at the top center of
the window.
For non full-screen, the X appears in a red box at
the right of the window’s title bar.

or

2 When the remote desktop is full screen, move
the cursor to the bottom left of the window:
= Click Start, Disconnect.
= Click Disconnect. You are asked to confirm that you want to
disconnect.
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The Virtual Front Panel

The Virtual Front Panel is a software equivalent of the front-panel key set, which
provides another alternate method for test set control. It may be displayed in a

separate window on the test set (or remote desktop) display.

The Virtual Front Panel is also available when using the test set directly,
provided that a mouse or other pointing device is attached to it.

Using the mouse, right-click the application display window, then select Utility >
Virtual Front Panel. The Virtual Front Panel appears, as shown below:

ﬂ TRX1 - Front Panel EI
FREQ Input/ Auto ‘ Mode
SoftKey 1/ | Channel | | Output | | Couple Marker | Systom Preset
——— | SPAN View/ BW Peak Quick User
X Scale || Display Search Save Preset
Softkey 2 | AmMpTD || Trace/ Marker .
Y Scale | | Detector Source , Save File
Mode Marker
SoftKey 3 Mode Setup Trigger Function Recall Print
_ M S / -
——— | Meas Sei?lsp C:l:frgl Restart Single Cont
SoftKey 4
Full Next Cancel Bk Sp
ell| coroon Zoom Windov Vol Up (Esc) Delete )
SoftKey 5 1 volDn|| 7 9
‘ ¢ ‘ Enter | » ‘ Mute 4 6
SoftKey 6
S | 1 3
SoftKey 7 Select/| | Tab || Tab
‘ Help [BLGEITY lSDﬂce - . 0

When you click a button in the Virtual Front Panel, it performs the operation of the
corresponding test set front-panel key. The buttons at the left of the panel, named
Key 1 through Key 7, perform the operation of the respective softkeys. The Rpg

Up and Rpg Down keys perform the operation of the knob.
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Programmatic Control of the Test Set

For information on how to send commands to the test set, using a VISA
connection, see the X-Series Signal Analyzer Programmer’s Guide, which is
available online at:

http://www.keysight.com/find/mxa_manuals

m The individual TRX instruments within the test set chassis are controlled using
separate VISA connections; see “TRX Selection" on page 46.

Getting Started Guide 133


http://www.keysight.com/find/mxa_manuals
http://www.keysight.com/find/mxa_manuals

5  Using Microsoft Windows Operating System

Capturing/Printing Displays and Windows

You need an external keyboard and mouse to use this feature.

Save the desktop:

134

1 Press Print Screen on the external This captures the desktop and saves it on the Windows
keyboard clipboard.
2 Open a graphics software program

like Microsoft Paint

w

Paste the clipboard contents into The keyboard shortcut Ctrl + v will paste the contents of
the program the clipboard.

S

Save the image in a file

Save the current active window:

1 Click on the window you want to This activates the window.
capture

2 Press Alt + Print Screen on the This captures the window and saves it on the Windows
external keyboard clipboard.

3 Open a graphics software program

like Microsoft Paint

S

Paste the clipboard contents into The keyboard shortcut Ctrl + v will paste the contents of
the program. the clipboard.

(3]

Save the image in a file.
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Windows Shortcuts and Miscellaneous Tasks

This section provides a list of Windows shortcuts (key combinations) that are
useful when you operate the test set without an attached mouse and keyboard.
(See also “Navigating Windows Without a Mouse" on page 118.) Although these
shortcuts are available in any Windows system, they are not commonly used when

a mouse and keyboard are attached.

Windows shortcuts (key combinations)

You can use the following combinations of front panel keys to perform basic
Windows tasks when using the test set without an attached mouse and keyboard.

Table 3-11

Windows shortcut key combinations

To do the following: Press:

Display the Windows Start Menu Ctrl+Esc
Cycle through all open applications Alt+Tab
Select the first menu of a menu bar Alt

Move through menu headings

Left Arrow, Right Arrow

Open (drop down) a menu

Down Arrow

Move through items in an expanded menu

Up Arrow, Down Arrow

Close the current menu selection Esc
Cancel the current menu bar selection Alt

Open an application’s control menu (usually the left-most Alt+Select
menu on the menu bar, starting with File)

In a dialog: move between tabs Ctrl+Tab
In a dialog: move forward through dialog box items Tab

In a dialog: move backward through dialog box items Shift+Tab

In a dialog: open a list box

Alt+Down Arrow

In a dialog list box or check box: select or deselect items

Select

In a dialog list box or check box: select or deselect one item at

Shift+Up Arrow, Shift+Down Arrow

atime
InMy Computer, expand a selected folder Enter
InMy Computer, open a folder one level up from the current Bk Sp

folder
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Navigating an Application Menu without a Mouse or Keyboard

This example uses Microsoft Excel, but you can use a similar sequence of
operations to select and execute any menu item of any application.

To select and execute the item Sheet > Rename option from the Format menu in
the menu bar shown below,

E3 Microsoft Excel - Book1

{4] ple Edt View Insert | Format | Iools Data Window Help NtroPOF  Adobe PDF

= _‘_E!J_J-_lj‘cﬂls... crbH | &z,ilillMJ
N EH H R L4
nmeloaal |
Al = A Column 3
A B | | Sheet » | Rename I H

; | AutoFormat. .. Hide

T’ Conditional Formatting. ..

4 | Stvle... Background...
%. Tab Calor...
(7]
| 8 |

n

perform the following operations:

1 Press Alt to select the File menu in the menu bar. The focus must be in the appropriate
window.

2 Use the Right Arrow and Left Arrow keys to move
horizontally to the Format menu.

3 Press the Down Arrow to expand the Format menu.

4 Use the Down Arrow and Up Arrow keys to move
vertically to the Sheet menu item.

5 Press the Right Arrow key to expand the Sheet The Rename sub-menu item appears
sub-menu. already selected. If another item in the
same sub-menu is required, use the
Down Arrow and Up Arrow keys to
move vertically to that item.

6 Press Enter to execute the selected action.
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Windows taskbar auto-hide feature

The Windows taskbar should always be in the auto-hide mode when using the test
set application. If the taskbar is not set to auto-hide, the lower part of the test set
display is obscured by the taskbar.

If a mouse is attached to the test set, and you move the mouse cursor to the
bottom of the display (either deliberately or accidentally), the taskbar
automatically appears. Provided that the taskbar is in auto-hide mode, you can
make it disappear again by moving the mouse cursor away from the bottom of the
screen.

If at any time the Windows taskbar is inadvertently set to the non-auto-hide mode,
you can restore the auto-hide behavior by doing the following:

Table 3-12 Restoring taskbar auto-hide mode

Step Notes

1 Click Start > Control Panel If not using a mouse, press Ctrl+Esc.

2 Click Appearance and Personalization, If you are not using a mouse, use the shortcut
Taskbar and Start Menu key combinations specified in the Section

“Windows shortcuts (key
combinations)" on page 135 to make these
selections.

3 Click the Taskbar tab The Taskbar and Start Menu Properties dialog
appears.
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Table 3-12 Restoring taskbar auto-hide mode

-

.lTaskbarand Start Menu Properties @

Taskbar | Start Menu | Toolbars

Taskbar appearance
Lock the taskbar

Auto-hide the taskbar

[TTuse small icans

Taskbar location on screen: [Bottom V]

Taskbar buttons: [Always combing, hide labels v]

Motification area
Cuskomize which icons and notifications appear in the
nokification area,

Preview deskkop with Aero Peek

Ternpararily view the deskkap when yvau move wour mouse ba the
Show deskkop button at end of the taskbar,

Use Aero Peek ko preview the deskkop

Howe dio I customize the taskbar?

[ [0]4 J[ Cancel ] Apply

4 Select the Auto-hide the taskbar check box  If you are not using a mouse, press Tab
repeatedly until the auto-hide option is
selected, then press Select to toggle the check
box state.

5 Click OK. This applies the change and closes the dialog
box.
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Windows startup folder

All Windows systems include a special folder, called the Startup folder. If a
program, or a shortcut to a program, is placed in the Startup folder (either by
Windows itself, or by a third-party application, or by any user), that program
automatically runs every time Windows is restarted.

When your test set is first configured by Keysight, shortcuts to the appropriate

application software and supporting programs are placed in the Startup folder.

The exact contents of the Startup folder depends on the options you purchased
with your test set.

You should never delete items that appear in the Startup folder, or move any
item from the Startup folder to another folder. Deleting or moving any item in
the Startup folder may cause applications not to start automatically when
Windows is restarted, or may cause certain options to be unavailable when
using the test set.

If you wish to view the contents of the Startup folder, do one of the following:

Either click Start, All Programs, then select Startup,
or,

Click start, My Computer, then navigate to the folder:
C:\Documents and Settings\All Users\Start Menu\Programs\Startup.

Additional startup items may also appear in the corresponding startup folder for
the user that is currently logged on. For example, the startup folder for the
administrator user is C:\Documents and Settings\administrator\Start
Menu\Programs\Startup.
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Troubleshooting

“Check the Basics" on page 142
“Problems with Microsoft Windows Operating System" on page 144

“Returning a test set for Service" on page 145

No operator serviceable parts inside. Refer servicing to qualified personnel. To
WARNING prevent electrical shock do not remove covers.
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Troubleshooting

Check the Basics

142

Is there power at the receptacle?

Is the test set turned on? Check to see if the blue power light and the green
fan LEDs beside the power switch are on and steady. Also, listen for internal
fan noise to determine if the test set cooling fans are running.

If other equipment, cables, and connectors are being used with your test set,
make sure they are connected properly and operating correctly.

If the test set cannot completely load or run the operating system, or the
instrument application is not successfully launched, the problem could be a
corrupt hard drive. If the test set gets far enough along in the boot process to
run the "Keysight Recovery System", perform the “Hard Drive Recovery
Process” on page 108. (The bootup process will be visible only if you have
connected an external monitor.)

Is the Measurement Application running? If not, there is a software launch
shortcut/icon on the desktop.

Does the test set application have the focus? (That is, is the blue window
banner highlighted?) If not, move focus to the application with Alt-Tab.

Review the measurement procedures being performed when the problem first
appeared. Are all of the settings correct?

If the test set is not functioning as expected, return the test set to a known
state by pressing Mode Preset.

Some test set settings are not affected by a Preset. If you wish to reset the test
set settings, press System, Power On, Restore Power On Defaults.

Is the measurement being performed, and the results that are expected,
within the specifications and capabilities of the test set? Refer to the
specifications in the data sheet for your test set, which is available on the
Keysight website:

http://www.keysight.com/find/e6640a

If the test set is not communicating via the LAN connection, check the LAN
cable connection at the front panel.

To meet specifications, the test set must be aligned. Either the Auto Align (On)
feature must be selected (press System, Alignments, Auto Align, Normal), or
the test set must be manually aligned.

Perform an Alignment. Press System, Alignments, Align Now, All.
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If the previously performed alignments did not resolve the problem, press
System, Alignments, Restore Align Defaults. Then press System, Alignments,
Align Now, All.

The test set must be powered on for 45 minutes prior to
performing alignments.

Is the test set displaying an error message? If so, refer to the Instrument
Messages Guide.

Check if the external frequency reference is selected but not available. Verify
that it is selected by pressing Input/Output, Freq Ref In. If External is selected,
changing the setting to Sense allows the test set to sense the presence of an
external reference and use it only if it is available. The frequency of the
reference should be set correctly.

If you are using a Windows program, other than the test set application, you
may notice it running slow. Place the test set application in single
sweep/measurement.
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Problems with Microsoft Windows Operating System

The Microsoft Windows operating system settings have been optimized for the
best performance. Modification of these settings may degrade test set
performance and measurement speed. Those that can be safely modified are
described in “Settings that can be changed" on page 97.

The E6640A EXM Wireless Test Set operates in an open Windows environment, so
you can install software on the test set. However, installation of non-approved
software may affect test set performance. Keysight does not warrant the
performance with non-approved software installed.
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Returning a test set for Service

Read the Warranty

The warranty for your test set is in the front of your Specifications Guide. Please
read it and become familiar with its terms.

If your test set is covered by a separate maintenance agreement, please be familiar
with its terms.

Service Options

Keysight Technologies offers several optional maintenance plans to service your
test set after the warranty has expired. Call your Keysight Technologies office for
full detalils.

Calling Keysight Technologies

Keysight Technologies has offices around the world to provide you with complete
support for your test set. To obtain servicing information or to order replacement
parts, contact the nearest Keysight Technologies office listed in the following
table. In any correspondence or telephone conversations, refer to your test set by
its product number, full serial number, and software revision.

Press System, Show, System, and the product number, serial number, and
software revision information is displayed on your test set screen. A serial number
label is also attached to the rear panel of the test set.
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Locations for Keysight Technologies

Americas

Canada
(877) 894 4414

United States
(800) 829 4444

Asia & Pacific

Australia
1800 629 485

India
1800112929

Malaysia
1800 888 848

Other Asia-Pacific countries:
(65) 6375 8100

Europe & Middle East

Austria
0800001122

France
0805980333

Israel
1809 343051

Netherlands
0800 0233200

Sweden
0200 882255

Brazil
5511 3351 7010

China
8008100189

Japan
0120 (421) 345

Singapore
18003758100

Belgium
0800 58580

Germany
0800 6270999

Italy
800599100

Russia
8800 5009286

Switzerland
0800 805353
Opt. 1 (DE), Opt. 2 (FR), Opt. 3 (IT)

Online assistance: http://www.keysight.com/find/assist

Contact us: http://www.keysight.com/find/contactus

Mexico
001 800 254 2440

Hong Kong
800 938 693

Korea
080 769 0800

Taiwan
0800 047 866

Finland
0800 523252

Ireland
1800 832700

Luxembourg
+32 800 58580

Spain
0800 000154

United Kingdom
0800 0260637
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Packaging the Test Set

Troubleshooting 6

Use original packaging or comparable. It is best to pack the unit in the original
factory packaging materials if they are available.

Test set damage can result from using packaging materials other than those

. specified. Never use styrene pellets in any shape as packaging materials. They
do not adequately cushion the test set or prevent it from shifting in the carton.
They cause test set damage by generating static electricity and by lodging in
the test set louvers, blocking airflow.

CAUTION

You can repackage the test set with commercially available materials, as follows:

1

Wrap the test set in antistatic plastic
to reduce the possibility of damage
caused by electrostatic discharge.

Use a strong shipping container.

The carton must be both large enough and strong enough
to accommodate the test set. A double-walled,
corrugated cardboard carton with 159 kg (350 Lb)
bursting strength is adequate. Allow at least 3 to 4 inches
on all sides of the test set for packing material.

Surround the equipment with three to
four inches of packing material and
prevent the equipment from moving in
the carton.

If packing foam is not available, the best alternative is
plastic bubble-pak. This material looks like a plastic sheet
filled with 1-1/4 inch air bubbles. Use the pink-colored
bubble which reduces static electricity. Wrapping the
equipment several times in this material should both
protect the equipment and prevent it from moving in the
carton.

Seal the shipping container securely
with strong nylon adhesive tape.

Mark the shipping container
“FRAGILE, HANDLE WITH CARE” to
assure careful handling.

Retain copies of all shipping papers.
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.NET, 99

A

acquisition integration, 65
add

a network connection, 97

a printer, 97
Administrator logon, 88
Adobe Acrobat Reader, 99
Agilent directories and files, 98
Agilent I/0 Libraries, 99
AgilentOnly user account, 98
alignments, 44
anti virus programs, 97
anti-virus software, 87, 104
applications, 51
Auto-hide Taskbar, 137
automatic updates, 101, 103
Automatic Updates, Microsoft

Windows, 97

B

backing up your instrument, 105
battery replacement, 27

beam forming, 82

boot wait time, 116

C

C drive usage, 107
calibration certificates, 49
calibration status, 48
changing

Windows system settings, 97
classic Windows display, 98
commands, 133
Computer Name, 124
computer name

how to locate it, 121
configurator, 50
configure applications, 51
connectors, front panel, 30
contents of shipment, 14
Control Panel

taskbar, 137
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Control Panel access, 100

Control Panel settings that can be
changed, 97

controlling Windows without a
mouse, 118

cooling the instrument, 16

D

D drive data storage, 107
data storage, 107

date and time setting, 97
defragmenting your disk, 105
desktop icons, 50

desktop saving, 134

Device Manager settings, Microsoft

Windows, 98
Device USB port, 106
directories, Agilent, 98
directories, Keysight, 98
disk defragmentation, 105
disk drive partitioning, 98
display annotations, 38
display print, 134
display save, 134
Display settings, Microsoft
Windows, 98
Domain Name, 124
drive C use, 107
drive D use, 107
drive partitioning, 98
drive recovery, 108
Drivers settings, Microsoft
Windows, 98
duplex, 52

E

E6640A
Computer Name, 124
computer name, 121
Domain Name, 124
popup menus, 127
virtual front panel, 132
electrostatic discharge (ESD)
protecting against, 28
Environment Variables settings,
Microsoft Windows, 98
environmental conditions, 25
Error Reporting settings, Microsoft
Windows, 98

F

file backup, 105
firewalls, 101, 102
fixing the hard disk, 109
font size, changing, 98

Fonts removal, Microsoft Windows, 98

front panel
connectors and keys, 30
keycode alternates, 128
popup menu alternative, 127
shortcut keys, 128
symbols, 41
virtual, 132

fuses, 24

G

gateway setting, 100
GPIB27 or GPIB28, 99

H

half-duplex, 54, 58, 64

hard disk recovery process, 109
hard drive recovery, 108
Hibernate, Microsoft Windows, 98
HiSLIP, 46

Host USB ports, 106

hostname setting, 100

icons, 50

IIS server, 98

initialization with mouse, 17
installing other software, 87
installing programs to drive C, 107
instrument location, 16
Instrument logon, 88, 89
instrument recovery, 109
instrument ventilation, 16
integration, 65

IP address setting, 100

K

Keycode Commands
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Windows, 135
keycode commands, 128
keys, 30

shortcut, 128
Keysight directories and files, 98
Keysight Recovery System, 108, 109
Keysight Technologies

locations, 146
Keysight Technologies, calling, 145
KeysightOnly user account, 98

L

LAN address, 62
LAN configuration, 100
launch XSA, 51
licenses for software, 86
line voltage, 24
loading a printer driver, 100
loading other software, 87
locating the instrument, 16
logon
accounts, 89
administrator, 88
instrument, 88

M

Microsoft SQL Server Desktop
Engine, 98
Microsoft Visual J# .NET, 99
Microsoft Windows
Automatic Updates, 97
Display settings, 98
Fonts removal, 98
network connection Windows
network connection, 97
Power Options, 98
printer install and configure, 97
set screen saver, 98
set time and date, 97
System Properties, 98
Tab settings, 98
user accounts, 97
virus protection, 97
Microsoft Windows system
settings, 97
MIMO, 71
MIMO (switched), 63
MIMO source settings, 73
MIMO type, 76
modulation accuracy, 67
modulation analysis, 78, 79
mouseless Windows navigation, 118
MSSQL$CDF service, 98
My Documents location, 107

150

N

navigating without a mouse, 118
network connection, Microsoft
Windows, 97

O

operating remotely, 119

p

packaging, 147

partitioning the hard-disk drive, 98

passwords, 88, 89

Performance settings, Microsoft
Windows, 98

port configuration, 52, 63

power cords, 25

Power Options, Microsoft
Windows, 98

power source, 24

power-on time, 23

print screen, 134

printer driver loading, 100

printer install and configure, Microsoft

Windows, 97
printer setup, 100
printing a window, 134
printing the desktop, 134
problems with shipment, 15
program storage, 107
programmatic control, 133

R

rack mounting, 16
radio standards, 63, 76
rear panel
symbols, 41
rear panel features, 40
recovering the hard drive, 108
recovery process, 109
recovery timing, 116
reduce power-on time, 23
registry entries, 98
remote analyzer configuration, 76
Remote Desktop
keycodes, 128
running, 122
Remote Operation
Connection Speed, 124
remote operation, 119
replacing battery, 27
restoring your instrument, 105
RF input port, 66
RF input port mode, 64

running Windows without a
mouse, 118

S

saving a window image, 134
saving data to internal drives, 107
saving programs on C drive, 107
saving the desktop image, 134
screen capture, 134
screen resolution setting, Microsoft
Windows, 98
screen saver settings, Microsoft
Windows, 98
security, 101
service options, 145
services running, 98
setting
gateway, 100
hostname, 100
ip address, 100
LAN, 100
shipment contents, 14
Shortcut keys
Windows, 135
shortcut keys, 128
SICL, 47
socket numbers, 133
socket ports, 47
software installed by customers, 87
software licenses, 86
source settings, 73
source sync control, 64
spyware, 104
Startup and Recovery settings,
Microsoft Windows, 98
Startup Folder
Windows, 139
storing data on D drive, 107
sub-instruments, 133
symbols, on front and rear panels, 41
system backup, 105
System Properties, Microsoft
Windows, 98
system recovery, 108
system restore, 105
system settings that can be
changed, 97

T

Tab settings, Microsoft Windows, 98
Taskbar
Windows, 137
telnet ports, 47
test set software, 86
third party software, 87
time and date setting, Microsoft
Windows, 97
triggers, 65
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TRX configuration, 71
TRX configurator, 50
TRX selection, 46, 75
turn on

with a mouse, 17
Tx beam forming, 82

U

updates, automatic, 97
updating Windows, 103
URL
contact us, 146
sales and service, 146
USB host ports, 106
USB Series A or B ports, 106
user accounts, 98
User Accounts location, 107
user accounts, Microsoft Windows, 97
user logon, 88
user logon accounts, 89
User Profiles settings, Microsoft
Windows, 98
user startup folder, 139
using the test set remotely, 119
using Windows without a mouse, 118

V

VI060A software, 86
V9077A software, 86
verifying contents, 14

virtual front panel, 132

virus protection, 87, 104
virus protection programs, 97
VXI-11, 47

W

warranty, 145
waveform file names, 75
window saving, 134
Windows, 118
Automatic Updates, 97
Control Panel, 137
Display settings, 98
Fonts removal, 98
Power Options, 98
print screen, 134
printer install and configure, 97
Remote Desktop
Installing, 120
Setting up, 120
screen capture, 134
set screen saver, 98
set time and date, 97
Shortcut keys, 135
Startup Folder, 139
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System Properties, 98
Tab settings, 98
taskbar
auto-hide, 137
user accounts, 97
virus protection, 97
Windows 7
operating system, 117
Windows Classic Style, 98
Windows firewall, 102
Windows Remote Desktop, 119
keycodes, 128
options, 124
Options Dialog
Experience Tab, 124
General Tab, 124
popup menus, 127
running, 122
Setting up Remote Computer, 120
setting up the E6640A, 119
Setting up Windows Systems, 120
32-bit, 120
virtual front panel, 132
windows security, 101
Windows services, 98
Windows settings, 97
Windows Style, 98
windows system, 117
Windows updates, 103

X

XSA, 51
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